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Vítáme vás v ESPRIT
ESPRIT má veškerou sílu, kterou potřebujete k obrobení jakéhokoli dílu... 

Obrábění plné, povrchové nebo rámové geometrie. ESPRIT je poháněn 
pomocí Parasolid, špičkovým modelářským nástrojem. Můžete vytvářet 
obráběcí nástrojové dráhy přímo z libovolného plného modelu. 

na CNC stroji libovolného typu... 
Fréza, soustruh, nebo drátový EDM. Programování libovolných 2, 3, 4 nebo 
5 os s ESPRIT. Soustružení a frézování s několika otočnými hlavami a 
vřeteny, s obráběcími nástroji nebo bez nich. A drátové EDM ESPRIT je 
prostě nejlepší na trhu. Když potřebujete řezat díly, nabízí ESPRIT výkonný, 
univerzální procesor a rozsáhlou knihovnu předdefinovaných formátů, 
schopných formátovat váš G kód prakticky pro libovolný CNC obráběcí 
nástroj. 

pro libovolné odvětví. 
ESPRIT se používá ve firmách po celém světě, od dílen s jedním 
zaměstnancem až po nadnárodní výrobce. 

Začínáme s ESPRIT vás naučí všechny základy obrábění dílů a navíc obsahuje 
pokročilé techniky, které pomáhají maximálně využít ESPRIT. 

Instalace ESPRIT     2 

Nápověda     5 

Podpora ESPRIT     9 

 
 
 
 
 
 
 
 

 
 
 



 

Instalace ESPRIT 
Před instalací ESPRIT nastavte správně datum na svém počítači a potom ho již 
neměňte. 
 
Důležité   Nesprávné datum může poškodit bezpečnostní modul a vyřadit 
ESPRIT z provozu. Software ESPRIT pak nefunguje, dokud vám nedoručíme 
náhradní bezpečnostní modul a nové heslo. 
 

Systémové požadavky 
Systémové požadavky pro ESPRIT 2003 se liší od požadavků ESPRIT 2002. 
Stávající uživatelé musí zkontrolovat své počítačové systémy, aby bylo jisté, že 
vyhovují nejnovějším systémovým požadavkům ESPRIT. 

• ESPRIT 2003 podporuje následující operační systémy: 
• Microsoft® Windows® XP (Home nebo Professional Edition) 
• Windows® 2000 (Service Pack 2 nebo vyšší) 
• Windows® NT 4,0 (Service Pack 5 nebo vyšší) 

Systém Windows® NT vstoupil 30.06.02 do prodloužené fáze životního cyklu produktu 
Microsoft. V červnu 2003 vstoupí do nepodporované fáze. ESPRIT 2003 bude 
poslední verze podporovaná systémem Windows® NT. Další informace o životním 
cyklu produktů Windows® naleznete na http://support.microsoft.com/lifecycle  
Systém Windows® NT není podporován pro ESPRIT Floating License jako Floating 
License Server ani jako Floating License Client využívající ESPRIT 2003. Aby bylo 
možné užívat ESPRIT Floating License, musí být server ESPRIT i všichni připojení 
klienti nainstalováni pod jedním z následujících operačních systémů: 

• Microsoft® Windows® XP 
• Windows® 2000 

• Počítač Intel Pentium nebo kompatibilní, 800 MHz nebo vyšší 
• Požadovaná RAM minimálně 128 MB, doporučená 256 MB nebo víc 
• 32 MB video karta s 24-bitovou barvou při rozlišení 1024 x 768 a OpenGL 
• 1 GB volné paměti na pevném disku 
• Mechanika CD-ROM nebo DVD 
• Myš 

 



3   Začínáme s Esprit 
• Paralelní nebo USB port 

• Microsoft® Internet Explorer verze 5,0 nebo vyšší 

ESPRIT 2003 je aplikace s jednou instancí a nepodporuje více instancí.  
ESPRIT neomezuje počet běžících instancí, ale pokud se rozhodnete spustit 
více než jednu instanci ESPRIT najednou, můžete se setkat s nečekanými a 
nežádoucími výsledky. 

Poznámka   Starší stroje (např. Pentium 233) jsou schopné používat ESPRIT 
2003, ale výsledky rozhodně nejsou ideální.  Použití přídavné paměti nebo 
rychlejších procesorů přímo úměrně zvyšuje výkon a kapacitu.  Pro zvládnutí 
instalace ESPRIT 2003 a pro všechny uložené soubory je zapotřebí dostatek 
odkládacího místa. 

Bezpečnostní modul 

Zapojte svůj bezpečnostní modul ("dongle") do vhodného portu na zadní straně 
počítače. Máte-li paralelní modul, zapojte ho do primárního paralelního portu 
(LPT1) na zadní straně počítače. Nezapojujte ho do sériového portu. ESPRIT 
není plně funkční, pokud modul není správně zasunutý. Bez modulu běží 
ESPRIT v "demonstračním režimu". Můžete používat ESPRIT, ale nemůžete 
vytvářet NC kód nebo ukládat jakékoli soubory. 

Dávejte dobrý pozor na svůj bezpečnostní modul, aby se vám neztratil nebo 
nepoškodil. Je nedílnou součástí softwaru a vaší licence. 

Důležité   Nezapojujte žádné páskové zálohovací systémy, přenosné CD-ROM, 
DVD přehrávače nebo rekordéry, Zip mechaniky, multifunkční kancelářské 
systémy (univerzální tiskárny, faxy, skenery, kopírovací přístroje) do paralelního 
bezpečnostního modulu. Tím by se poškodil modul. 

Jediné zařízení, které můžete připojit na zadní stranu paralelního 
bezpečnostního modulu, je paralelní tiskárna. 

Jestliže se váš modul poškodí, software ESPRIT nefunguje, dokud vám na vaše 
náklady nedoručíme náhradní bezpečnostní modul a nové heslo. Výměna 
modulu není zahrnuta v softwarových servisních smlouvách. 

Odpovědnost za ztrátu nebo odcizení modulu nesete vy sami. Zjistěte si u své 
pojišťovny, jestli vaše podnikové pojištění pokrývá plnou hodnotu vašeho 
softwaru ESPRIT. 
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Instalace ESPRIT z CD 

1 Vložte ESPRIT CD do mechaniky CD-ROM nebo DVD. 

2 Vyberte "Install ESPRIT". 

Pokud se tato obrazovka neobjeví automaticky, vyberte Run v menu Windows Start, 
vyhledejte mechaniku CD-ROM a vyberte SETUP.EXE. Klepněte na OK. 

3 Postupujte podle pokynů na obrazovce. 

Používání ESPRIT 

Když začínáte používat ESPRIT: 

Vyberte ikonu ESPRIT na ploše Windows nebo, 

V menu Windows Start vyberte Programy a pak ESPRIT. Na výběr jsou následující 
možnosti: 

 

Volbou ESPRIT otevřete novou relaci ESPRIT.  

Ostatní položky menu ESPRIT: 

ESPRIT License Manager: Aktualizuje hesla pro přidávané produkty a instaluje 

WDnc.exe: Pro pokročilé uživatele, individualizace DNC  

Wed.exe: Upravuje NC soubory 
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Nápověda 

Nápověda v ESPRIT je k dispozici v několika formách. Na obrazovce můžete zobrazit 
stručná vysvětlení položek, když přes ně přejíždíte ukazatelem myši, nebo s použitím 
kontextově závislé nápovědy zobrazit krátký odstavec, který je popisuje. Menu Help 
obsahuje rozsáhlejší témata nápovědy s grafickými příklady, včetně výukových. 

Nápověda na obrazovce 
Přidržte ukazatel myši na libovolné ikoně a pod kurzorem se objeví název ikony. V levém 
dolním rohu obrazovky se současně zobrazí podrobnější vysvětlení. 

 
Chcete-li vyvolat kontextově závislou nápovědu, vyberte ikonu nápovědy What's This? a 
potom vyberte kteroukoli ikonu. Na obrazovce se objeví krátký odstavec, popisující tento 
příkaz. 
 

 
Chcete-li vyvolat položky menu kontextově závislé nápovědy, přidržte kurzor na 
libovolném příkazu menu a stiskněte klávesu F1. 
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Kromě toho můžete stisknout tlačítko Help v dialogovém okně a otevřít okno Help s 
informacemi o tom, jak používat nastavení v tomto dialogovém okně. 
 

 
Online nápověda ESPRIT 
Vyvolejte menu Help a vyberte ze souborů nápovědy dodaných s vaší verzí ESPRIT. 
Tyto soubory obsahují vyčerpávající informace o tom, jak používat ESPRIT, spolu s 
grafickými ilustracemi a výukou.  
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Rovněž můžete kdykoli stisknout klávesu F1 a zobrazit online nápovědu ESPRIT. 
 

 
 
Nápověda ESPRIT je založená na HTML, což usnadňuje navigaci mezi tématy a 
vyhledávání přesných informací, které potřebujete. Chcete-li vytisknout jakékoli 
téma, stiskněte tlačítko Print nahoře v okně Help. Pro návrat do okna hlavních 
témat (zobrazeného výše), stiskněte tlačítko Home. S použitím tlačítek Forward a 
Back můžete procházet tam a zpátky témata, která jste již prohlíželi. 
V navigačním podokně okna Help jsou čtyři karty, které pomáhají hledat potřebné 
informace. Pokud nechcete zobrazit tyto karty, stiskněte tlačítko Hide. Chcete-li je 
opět zobrazit, stiskněte tlačítko Show. 
Karta Contents prezentuje informace ve formátu kapitol. Témata nápovědy jsou 
seskupena logicky podle oblastí. Pokaždé když vyberete téma v seznamu, otevře 
se toto téma automaticky v pravé části okna Help. 
Karta Index prezentuje informace o tématech v abecedním pořadí. Můžete 
procházet seznam nebo napsat několik počátečních písmen hesla, které hledáte. 
Chcete-li otevřít zvýrazněnou položku v seznamu, stačí stisknout Enter nebo 
tlačítko Display. Nebo můžete otevřít toto téma dvojím klepnutím na položku. 
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Karta Search umožňuje vyhledávat konkrétní slovo nebo větu v každém tématu 
souboru nápovědy. Napište slovo nebo větu (pokud chcete hledat přesnou větu, 
vložte ji do uvozovek) a pak stiskněte tlačítko List Topics nebo jen klávesu Enter. 
Zobrazí se všechna témata nápovědy, která obsahují příslušné slovo nebo větu. 
Karta Favorites umožňuje uložit do paměti seznam témat nápovědy, k nimž se často 
vracíte. Chcete-li přidat téma do seznamu Favorites, otevřete téma (z karty Contents, 
Index nebo Search), umístěte kurzor do pole Current Topic a stiskněte Enter. 

Nápověda ESPRIT na Webu 
Získejte nejaktuálnější informace o ESPRIT, nových funkcích a vylepšeních produktu, 
nejnovějších verzích, post procesorech, tipech pro pokročilé a kreativních řešeních. 

 
 
ESPRIT CustomerWeb je skupina čtyř webových stránek, jejichž úkolem je sloužit 
potřebám společenství ESPRIT. Homepage CustomerWeb je centrálním bodem pro 
komunitu online uživatelů ESPRIT. Obsahuje aktuální informace o všech produktech 
ESPRIT a nabízí odkazy na všechny ostatní online oblasti ESPRIT. Zaregistrujte se 
pro ESPRIT CustomerWeb na:  

http://www.dptechnology.com/espritweb 

Všeobecná nápověda Windows 
V menu Windows Start vyberte "Nápověda". Microsoft poskytuje všeobecné 
informace o operačním systému Windows. 
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Podpora ESPRIT 

Webová stránka DP Technology 
Webová stránka DP Technology obsahuje široké spektrum informací o společnosti a 
jejích produktech. Tuto webovou stránku můžete najít na: 

http://www.dptechnology.com 

Budete-li potřebovat jakoukoli pomoc, zašlete e-mail na adresu:  

support@dptechnology.com 

Telefonní asistence 
Kontaktujte nejprve svého prodejce. Prodejci ESPRIT poskytují specializované 
informace související s konkrétním řešením, které pro vás připravili. To je nejlepší 
místo kde začít. 
Pokud nemáte prodejce, obraťte se na nejbližší kancelář DP Technology.  
 
Spojené státy: 
západní pobřeží  středozápad  jihovýchod 

 
DP Technology Corp. DP Technology Corp. DP Technology Corp. 
1150 Avenida Acaso  1001 E. Touhy Avenue 8535 Cliff Cameron Drive 
Camarillo, CA 93012  Suite 300 Suite 112   
  Des Plaines, IL 60018 Charlotte, NC 28269      
Tel: 805.388.6000  Tel: 847.297.8100 Tel: 704.594.9551                
Fax: 805.388.3085  Fax: 847.297.8107 Fax: 704.594.9802 

Email: support@dptechnology.com 

Evropa: 
evropské centrály Germany 
 
DP Technology Corp. DP Technology Corp.                                                     
“Le Thčbes” Sommerleite 1                                                                      
68 Allée de Mycénes D-96 148 Baunach                                                               
34000 Montpellier Germany                                                                             
France 
 
Tel: +33 4 67 64 99 40 Tel: +49 9 54 49 80 3 53  
Fax: +33 4 67 64 99 41 Fax: +49 9 54 49 80 3 54 
 
Email: esprit.europe@dptechnology.com Email: esprit.germany@dptechnology.com 
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Softwarová servisní smlouva (SMC) 
Naším cílem je pomáhat uživatelům ESPRIT k úspěchu. Jsme přesvědčeni, že 
nejlepším způsobem jak toho docílit je program SMC. Účastníci mají k dispozici... 

• Neomezená telefonní asistence 
• Neustálé aktualizace softwaru a dokumentace ESPRIT 
• ESPRIT de Corps Newsletter, náš informační a technický bulletin 
• Možnost participovat a mít prospěch z testování v praxi. 
• 24-hodinový webový přístup do asistenčního centra DP a na stránku FTP 

Další detaily o DP Technology SMC můžete získat na telefonu (805)388-6000. 
 



 

 

Základy ESPRIT
Tato kapitola seznamuje s pracovním prostředím ESPRIT, vysvětluje, jak 
otevírat a ukládat soubory součástek, a ukazuje základy vytváření 
součástek a linií v ESPRIT. 

Než začnete používat ESPRIT, musíte mít také základní znalost svého 
operačního systému a jeho konvencí. Musíte vědět, jak se používá myš a 
standardní menu a příkazy. Rovněž musíte vědět, jak se kopírují, otevírají, 
ukládají, tisknou a zavírají soubory. Tyto techniky si můžete prostudovat v 
dokumentaci k Microsoft® Windows®. 

Přehled obrazovky     12 

Ukládání a otevírání souborů     17 

Kreslení součástek v ESPRIT     19 

Definování linií     26 
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Přehled obrazovky 

Než začnete pracovat se součástkami, podívejme se letmo na obrazovku ESPRIT. 
Toto okno se zobrazuje, když vytváříte nový soubor nebo otevíráte existující. 
Okno ESPRIT obsahuje menu a standardní panely nástrojů na horním okraji 
obrazovky, grafickou pracovní plochu, kde můžete zobrazovat svou práci, a stavovou 
plochu na dolním okraji obrazovky, kde se zobrazují dynamické informace o prostředí 
a aktuálním příkazu nebo činnosti. 

 
Project Manager obsahuje seznam všech operací, nástrojů a linií v aktuální relaci a 
umožňuje spravovat, třídit a měnit pořadí těchto položek. 

Property Browser zobrazuje informace o libovolné položce vybrané na grafické 
pracovní ploše Project Manager. Můžete zobrazovat a měnit jednotlivé vlastnosti 
pro vybranou položku. 
 

(stiskni F2) 

(stiskni Alt + Enter) Stavová plocha

Grafická pracovní plocha

Dynamic 
dokovací 
oblast pro 
panely 
nástrojů 

Standardní panely nástrojů 

Linie 

Nástroje 

Operace 
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Panely nástrojů 
Chcete-li zobrazit nebo skrýt některý panel nástrojů vyberte Toolbars z menu View. 
Nové panely nástrojů se přidávají na pravé straně obrazovky, ale můžete je 
přesunout na pracovní plochu nebo do jakéhokoli místa v okolí pracovní plochy.  

Chcete-li přemístit panel nástrojů, přidržte ukazatel myši 
na dvojité čáře (na horní nebo levé straně panelu 
nástrojů) a přetáhněte panel nástrojů na nové místo. 

Grafická pracovní plocha 
Počáteční orientace zobrazení je standardně nastavena na pohled shora se 
zobrazenými osami XYZ. Osa X je vodorovná, osa Y svislá a osa Z směřuje k vám. 
Pokud chcete přepnout na jiný pohled, použijte rozbalovací menu View vedle pravého 
horního rohu obrazovky. Chcete-li zobrazit nebo skrýt souřadnice XYZ, vyberte XYZ 
Axis v menu View. 
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Pohledy 
Chcete-li dynamicky otáčet obraz svého výkresu ve třech rozměrech okolo vybraného prvku, 
vyberte Rotate View... 

 
 
... pak přidržte stisknuté levé tlačítko myši na libovolné čáře (včetně os x, y a z), segmentu, 
kruhu, oblouku nebo bodu a přetáhněte myš ve směru, kam chcete otočit obraz. 

Druhou možností je přidržet stisknuté levé tlačítko myši na volné ploše na pracovní ploše a 
tažením myši volně otáčet obraz. 

Když dosáhnete pohledu, který se vám líbí, můžete ho uložit a vrátit se k němu později. 
Uložení pohledu: 

1 Vyberte View Planes           z panelu nástrojů Layers and Planes. 
 

2 Stiskněte tlačítko New... 
 
 
 
 
 
 
 
 
 
 
 
3 Napište název a stiskněte OK. 

Tento příklad vytváří pohled s názvem "můj nový pohled". 

 
 
 

 



Základy ESPRIT   15 

 

 
Pak můžete kdykoli vybrat tento pohled z 
rozbalovacího seznamu. 

 

 

 

 

Stavová plocha 
Stavová plocha na dolním okraji obrazovky ESPRIT poskytuje dynamické informace o 
aktuálním pracovním prostředí. Když vybíráte příkazy nebo pohybujete kurzorem, 
informace se neustále aktualizují. 

 

 
 

Oblast výzev: Oblast výzev je pravděpodobně nejdůležitější část obrazovky ESPRIT. 
Výzvy vám sdělují, co máte právě udělat. Vždy věnujte pozornost tomu, co vám 
sděluje výzva. 
Typ obrábění: Typ obrábění znamená aktuální obráběcí režim. Obráběcí režim se 
nastavuje volbou příkazu v menu Machining pro operaci SolidMill, SolidTurn, 
SolidMillTurn nebo SolidWire. 
Režimy na výběr: Volbou těchto položek se aktivuje nebo deaktivuje režim. Režimy 
na výběr jsou podrobněji popsány na další stránce. 
Barva a typ čáry: ESPRIT automaticky přiřazuje standardní barvy a typy čar různým 
typům prvků (např. geometrie, linie nebo dráha nástroje). Barva nebo typ čáry se dá 
kdykoli změnit. Barva se přitom mění s použitím malého okénka. Typ čáry se mění 
volbou čáry úplně vpravo. Zobrazená barva a typ čáry jsou použity na všechny nově 
vytvořené prvky. 
Chcete-li se vrátit ke standardnímu přiřazení barev k prvkům, vyberte Default 
Attributes z menu Create na horním okraji obrazovky. 
Pro změnu standardních barev a typů čar vyberte Options z menu Tools.  
Souřadnice polohy: Dynamicky zobrazuje polohu kurzoru. 

 

Režimy na výběr 

Typ obrábění

Souřadnice polohy
Aktuální jednotky 

Barva a typ čáry 

Oblast výzev 
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Aktuální jednotky: Chcete-li přepínat aktuální jednotky mezi metrickými a palci, 
vyberte System Unit z menu Tools. 

Režimy na výběr 
Následující položky můžete vybírat ve stavové oblasti, chcete-li měnit režimy: 

 
 
Když je režim šedě vybarvený, znamená to, že je režim vypnutý. Vyberte režim pro 
zapínání a vypínání. 
 

Režim SNAP: V tomto režimu kurzor rozpoznává středy a koncové body čar a 
segmentů a středy kruhů a oblouků jako platné volby bodů. 
Při zapnutém režimu SNAP se kurzor změní na: 

  když se pohybuje na konci segmentu nebo oblouku 
  když se pohybuje okolo středu 
  když se pohybuje kolem středu kruhu nebo oblouku 

 
Režim INT: V tomto režimu kurzor rozpoznává průsečíky segmentů, čar, oblouků a 
kruhů jako platné volby bodů. 
 
Při zapnutém režimu INT se kurzor změní na        když se pohybuje kolem průsečíku.  
 
Režim GRID: ESPRIT používá nastavení mřížkové konfigurace z dialogového okna 
Options (v menu Tools vyberte Options a potom kartu Input). To umožňuje vybírat z 
definovaného neviditelného pole míst na obrazovce v reakci na výzvy pro body, úhly, 
vzdálenosti atd. 
 
Může být nutné nastavit rozměry mřížky tak, aby vyhovovaly hodnotám na vašem 
výkresu součástky. 
 
Režim HI: Když je zapnutý režim HI, žádá vás ESPRIT vždy o potvrzení vybraných 
prvků. To umožňuje vybírat z prvků, které jsou blízko sebe nebo dokonce na sobě. 
 
ESPRIT se ptá "Is this the correct choice" a zvýrazňuje prvek v blízkosti zvoleného 
bodu. Chcete-li odpovědět "Ne", stiskněte pravé tlačítko myši. ESPRIT zvýrazní další 
prvek. Když se zvýrazní správný prvek, odpovězte "Ano" stisknutím levého tlačítka 
myši. 
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Ukládání a otevírání souborů 

Po skončení práce v ESPRIT potřebujete uložit svou práci do paměti a později ji opět 
vyvolat. Rovněž můžete potřebovat otevřít model součástky, který byl vytvořen jiným 
softwarem CAD. Pro práci se soubory součástek používejte ikony na standardním 
panelu nástrojů umístěném v blízkosti levého horního rohu obrazovky ESPRIT. 

 

Nový: Zavírá aktuální soubor, takže můžete začít pracovat na novém souboru. 
Jestliže jste provedli změny v aktuálním souboru, ESPRIT vás před zavřením 
souboru požádá, abyste tyto změny uložili. 

Otevřít: Otevírá dříve uložený soubor. Použijte rozbalovací seznam "Files of type", 
obsahující všechny soubory s určitou příponou. Ten usnadňuje vyhledání souboru, 
který potřebujete. Pokud má hledaný soubor příponu, která není uvedena v seznamu, 
vyberte "All Files (*.*)". 

 
 

 

 

 

 

 

 

Uložit  
 

Otevřít 
 

Nový 
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Uložit: Ukládá aktuální soubor. Soubory ESPRIT se ukládají s příponou ".esp". 
Chcete-li konvertovat soubor na jiný formát, vyberte rozbalovací menu "Save as 
type" a vyberte příponu souboru. 

Import souboru CAD 

Můžete importovat soubor CAD nebo vytvořit část výkresu součástky v ESPRIT 
a pak sloučit soubor CAD s prvky ESPRIT. 

1 Vyberte Open          ze standardního panelu nástrojů nebo stiskněte Ctrl+O. 

2 Stiskněte tlačítko Options... 

 
 
3 S použitím rozbalovacího seznamu "File 

Type" nastavte možnosti pro každý typ 
souboru CAD. Každý typ souboru CAD 
má jiné možnosti. 
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Např. když importujete soubory 
Parasolid, SolidWorks nebo Solid 
Edge, nezapomeňte vybrat buď 
"Import as solid", nebo "Surfaces". 
Když vyberete Wireframe, vytvářejí 
se podél povrchových hran prvky 
drátové kostry. . 

4 Po nastavení možností stiskněte tlačítko OK a vrátíte se do dialogového okna 
Open. 

5 Vyberte soubor, který chcete importovat. Pro snazší vyhledání souboru, který 
potřebujete, vyberte příponu souboru v rozbalovacím seznamu "Files of type". 

6 Chcete-li zachovat prvky vytvořené v ESPRIT a sloučit s nimi prvky souboru 
CAD, zaškrtněte možnost Merge. 

7 Vyberte Open pro import souboru CAD do ESPRIT. 

Kreslení součástek v ESPRIT 

Pro vytváření součástek v ESPRIT můžete použít kterýkoli z následujících prvků: 

• 2D geometrie jako např. čáry, oblouky a body 

• 3D NURB povrchy a křivky 

• Plné modely 
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2D geometrie 

Chcete-li zobrazit panely geometrických nástrojů, vyberte Unbounded Geometry 
nebo Bounded Geometry z menu Create. Panel nástrojů Geometry je standardně 
umístěn na pravé straně obrazovky ESPRIT. 

 
S použitím panelu nástrojů Unbounded Geometry se vytvářejí spojité geometrie jako 
např. čáry, kruhy a elipsy. S použitím panelu nástrojů Bounded Geometry se vytvářejí 
geometrie, které mají určitá omezení, jako např. segmenty, oblouky a částečné 
elipsy. Panely nástrojů se dají používat k vytváření bodů nebo polí bodů a k 
ořezávání, fasetování či zaoblování prvků. 

Poznámka   Když vyberete jednu z ikon geometrií, nezapomeňte postupovat podle 
výzev v levé dolní části obrazovky. 

2D geometrie se používá jako základ pro plné modely a povrchy a také k 
definování tvaru pro linie, které mohou být využity při soustružení a 2D frézování. 
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3D povrchy a křivky 
Následující příkazy v menu Create otevírají panely nástrojů související s vytvářením 3D 
NURB povrchů: 
 

 
 

Surfaces: Vytvářejí primitivní povrchy, jako např. kužely, válce a sféry, stejně jako 
komplexní povrchy založené na kombinacích jiných prvků. Rovněž vytvářejí prolnuté 
nebo přechodové povrchy mezi vybranými povrchy. 

Curves: Vytvářejí NURB křivky z bodů a jiných prvků nebo konvertují prvek na NURB 
křivku. 

Surface Curves: Povrchové křivky jsou křivky, které náleží k definovanému povrchu. 
Povrchové křivky se používají k ořezávání povrchů, k nimž patří, nebo jako základ pro
vytváření nových povrchů. 
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Plné modely 
Chcete-li vytvářet plné modely, vyberte Solid Modeler z menu Create. 
 

 
 
Můžete vytvořit 2D tvar, s úkosem nebo bez něj, podél přímé dráhy nebo otočit tvar kolem 
definované osy a vytvořit tak 3D plný model. Když vytvoříte nový plný tvar, můžete ho použít 
k přidání nebo odstranění materiálu z existujícího plného modelu. Kromě toho můžete 
zaoblovat nebo srážet hrany plného modelu. 

Vrstvy 
Vrstvy se používají k zobrazení nebo skrytí různých aspektů vašeho výkresu. Umístěte prvky 
libovolného typu do pojmenované vrstvy a pak tuto vrstvu vypněte; tím skryjete všechny 
položky v této vrstvě. Prvky nejsou vymazány, jsou jen dočasně skryté. Kdykoli můžete 
vrstvu zase zapnout. 
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Vytvoření vrstvy: 
1 Vyberte Layers          z panelu nástrojů Layers and Planes. 
 

 
2 Stiskněte tlačítko New... 

3 Napište název a stiskněte OK. 
Tento příklad vytváří vrstvu s názvem "má nová 
vrstva". 

 

 
 

Nová vrstva se stává aktivní vrstvou. Na tuto vrstvu jsou 
umístěny všechny nově vytvořené položky. Chcete-li 
změnit aktivní vrstvu, vyberte jinou vrstvu z rozbalovacího 
seznamu.  

Chcete-li skrýt nebo zobrazit položky na vrstvách: 

1 Vyberte Layers         z panelu nástrojů Layers and 
Planes. 

2 Zaškrtněte vrstvy, které chcete zobrazit, a zrušte zaškrtnutí vrstev, které 
chcete skrýt. 

Poznámka   Nerušte zaškrtnutí aktivní vrstvy, protože by všechny nové prvky, 
které vytvoříte, byly skryté. 
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Přemístění prvků na jinou vrstvu: 

1 Vyberte jeden nebo více prvků (chcete-li vybrat více prvků, přidržte klávesu Ctrl a 
vybírejte nebo přetáhněte výběrový kurzor přes skupinu prvků). 

2 V Property Browser (zobrazí se stisknutím Alt+Enter) stiskněte tlačítko Layer a pak 
ve výběrovém seznamu vyberte jinou vrstvu.  

 
Můžete také použít výběrovou šipku vpravo od rozbalovacího seznamu, vybrat prvek 
na pracovní ploše a vyvolat vlastnost Layer z tohoto prvku. 

Pracovní roviny 
Nové prvky se vytvářejí paralelně s rovinou UV os UVW. Chcete-li zobrazit osy UVW na 
pracovní ploše, vyberte UVW Axis z menu View. 
 

 
 

Počátek UVW je standardně umístěn v x0, y0, z0 a paralelně s rovinou XY. 
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Pokud chcete změnit orientaci UVW, vyvolejte rozbalovací seznam Work Planes. 
 

 
 
Můžete změnit orientaci UVW na ZXY nebo YZX. Chcete-li vrátit pracovní rovinu do 
standardní polohy, vyberte XYZ. 

Vytvoření individuální pracovní roviny: 

1 Vyberte Work Plane z menu Edit. 

2 S použitím příkazů v panelu nástrojů Modify 
Work Plane změňte orientaci os UVW. Další 
informace o každé ikoně naleznete v online 
nápovědě ESPRIT. 

Každá nová geometrie bude založena na nové orientaci UVW. 

3 Vyberte Work Planes          z panelu nástrojů Layers and Planes. 
 

4 Stiskněte tlačítko New... 

5 Zadejte název a stiskněte OK. 

Tento příklad vytváří pracovní rovinu s názvem "má 
nová rovina". 
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Nová pracovní rovina je přidána do 
rozbalovacího seznamu. Kdykoli můžete 
vybrat tuto orientaci UVW. 

Definování linií 

Linie se používají jako základ pro soustružení, drátové EDM a 2D frézování. Zahrnují 
vlastnosti obrábění, jako jsou např. směr řezu, hloubka, řezná strana a pracovní 
souřadnice. Linie můžete zobrazovat v Property Browser (Alt+Enter). 
 

 
Při vytváření NC operací s použitím příkazů v menu Machining vás ESPRIT obvykle 
vyzývá, abyste vybrali linie. Obráběcí operace automaticky přebírá vlastnosti obrábění 
z vybrané linie.  
 
Když jsou vytvářeny linie, jsou přidávány do Project Manager (zobrazí se stisknutím klávesy 
F2) na kartě Features. Ten se rovněž nazývá Feature Manager. 
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Chcete-li zobrazit panel nástrojů Features, vyberte Features z menu Create. 

 
Při změně řetězce nebo linií PTOP (popsaných níže) vyberte Features z menu Edit a 
zobrazí se panel nástrojů Edit Features. 
 

 
Když je vytvořena linie, je klasifikována jako jedna z následujících: 

• Řetězcová linie 

• PTOP 

• Linie 

Typ linie se zobrazuje pod vlastností Element Type v Property Browser. 

 



28 Začínáme s Esprit 
 
Řetězcové linie 
Jednotlivé linie jsou považovány za řetězcové. Řetězcovou linií může být hranice 
okolo součástky (jak je znázorněno na následující ilustraci), jednoduchá kapsa nebo 
dráha sestavená z 2D prvků. Řetězcová linie může být otevřená nebo uzavřená 
smyčka prvků a definuje počáteční místo, směr a koncové místo pro řeznou dráhu. 
 

 
 
Chcete-li vytvořit řetězcovou linii z vybraných 2D prvků, použijte ikony Auto Chain 
nebo Manual Chain. Řetězcové linie se vytvářejí automaticky, když použijete ikony 
Pocket, Face Profile, Part Profile nebo Turning Profiles. 
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PTOP 
Linie PTOP (point-to-point) definuje dráhu propojující řadu otvorů nebo bodů. Linie PTOP 
se běžně používají pro vrtací práce a mohou se používat také pro ruční frézování. 
Nástroj sleduje tuto dráhu a vyvrtává každý otvor. 
 

 
 
S použitím ikony Manual PTOP se vytváří linie PTOP z vybraných prvků. K definování 
dráhy můžete vybrat body nebo kruhy geometrie. Linie PTOP se vytvářejí automaticky, 
když použijete ikonu Holes. 
Linie PTOP obsahují informace o průměru a hloubce otvoru stejně jako o průměru a 
hloubce úkosu a zahloubení. 
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Linie 
Skupina jednotlivých linií, které zahrnují obráběnou plochu, je považována za normální 
linii. Např. linie Part (Součástka), která obsahuje několik linií v uzavřených hranicích, nebo 
linie Pocket (Kapsa), která obsahuje dílčí kapsy nebo ostrovy. Tyto linie jsou 
reprezentovány složkou v Project Manager. 
 

 
S použitím ikony Pocket se vytvářejí linie Part nebo Pocket. Linie Part obsahuje všechny 
linie, které se nacházejí uvnitř vybrané hranice součástky. Chcete-li vytvořit linii Part, 
vyberte ikonu Pocket a pak hranici okolo součástky. To je nejrychlejší způsob jak vytvořit 
několik linií současně. 

Další informace 
Další informace o liniích obecně a detailní informace o každé ikoně v panelu nástrojů 
Features najdete v online nápovědě ESPRIT (stiskněte klávesu F1 v ESPRIT). Nápověda 
ESPRIT obsahuje podrobně vysvětlené procedury, grafické příklady a výuku. 
 



 

 

Lekce 1

Tradiční SolidMill

Tato lekce vysvětluje, jak obrábět běžnou 2-osou součástku s použitím 
tradičních operací SolidMill. Naučíte se, jak obrábět čelo horní části součástky 
znázorněné níže, vrtat otvory a řezat drážky a kapsy. 
 

 
 
V této lekci se naučíte toto: 

• Import souboru CAD     32 
• Vytvoření kapsové linie     33 
• Vytvoření standardních frézovacích operací     35 
• Simulace     56 
• Generování NC kódu     58 
• Přenos NC kódu do NC stroje     59 

 
 
 
 
 



34 Začínáme s Esprit 
 

Tato lekce používá metrické hodnoty. Než začnete s touto lekcí, přesvědčte se, že je 
parametr System Unit nastaven na Metric. V menu vyberte Tools → System Unit → Metric. 

Import souboru CAD 

V této lekci budete importovat plný model uložený jako soubor Parasolid (.x_t). 

1 Vyberte Open         ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor: 
\Getting Started\SolidMill\Mill_Part_A.x_t 

3 Změňte na pohled Isometric a vyberte Shaded          z panelu nástrojů View. 

 
 
 

4 Přesvědčte se, že jsou zapnuté režimy HI a 
SNAP. Stavová oblast v pravém dolním rohu 
obrazovky musí vypadat jako na obrázku 
vpravo.  
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Vytvoření kapsové linie 

Než můžete začít obrábět tuto součástku, musíte vytvořit linie definující každou plochu, 
kterou chcete řezat. Všechny linie, potřebné k obrábění této součástky, můžete vytvořit 
najednou s použitím příkazu Pocket v panelu nástrojů Features. 

V menu vyberte Create → Features, aby se zobrazil panel nástrojů Features. 

2    V panelu nástrojů Features vyberte Pocket           . 

V oblasti výzev jste požádáni, abyste vybrali hranici kapsy “Select Pocket’s 
Boundary”. 

3    Vyberte hranici okolo horního čela součástky.  

Při zapnutém režimu HI se hranice musí zvýraznit jako na obrázku a musí se 
zobrazit název "smyčky". Hrany spojené s plným čelem se nazývají "smyčky čela". 

 

 
Jestliže se horní smyčka nezvýrazní jako na obrázku, odpovězte "Ne" stisknutím 
pravého tlačítka myši. 

4    Když se zvýrazní správná smyčka čela, odpovězte "Ano" stisknutím levého tlačítka 
myši. 
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Protože jste vybrali vnější hranici součástky, ESPRIT automaticky vyhledá všechny 
linie uvnitř této hranice. To se nazývá linie "Part" (Součástka). Každá jednotlivá linie 
v rámci této součástky přebírá hloubku z plného modelu a má směrovou šipku, která 
ukazuje směr obrábění. 
 

 
Chcete-li zobrazit každou linii ve Feature Manager, stiskněte klávesu F2 a pak 
vyberte kartu Features. Když je linie vybraná ve Feature Manager, zvýrazní se na 
pracovní ploše. 
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Vytvoření standardních frézovacích operací 
V menu Machining vyberte SolidMill Traditional → SolidMill Traditional, aby se 
zobrazil panel nástrojů. 
 

 
Tím přepnete ESPRIT do režimu SolidMill. Režim obrábění je zobrazen ve stavové 
oblasti v pravém dolním rohu obrazovky.  
 

 
 

ESPRIT má tři režimy obrábění: SolidMill, SolidTurn a SolidWire.  

V aktuální relaci smíte být vždy jen v jednom režimu. Když vyberete některý z příkazů 
řezání v menu Machining nebo zobrazíte panel nástrojů pro obrábění, dostanete se do 
příslušného režimu. Jestliže otevřete panel nástrojů, který používá jiný režim obrábění, 
zavře se aktuální panel nástrojů a je nahrazen novým. Jakmile je vytvořena obráběcí 
operace, zamkne se režim pro tento soubor. 
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Nastavení frézy 
Nastavení stroje umožňuje definovat výstup NC kódu, např. typ jednotky (palce nebo 
milimetry), absolutní či inkrementální programování, počáteční umístění stroje atd. 

1 V menu Machining vyberte Common Machining → Machine Setup.  

Zobrazí se dialogové okno SolidMill Machine Setup. Pokud chcete vytvářet 
soustružnické operace, zobrazí se místo toho dialogové okno SolidTurn 
Machine Setup. 

 

 
2 Nastavte hodnoty na stránce Origin a stiskněte OK.  
Poznámka   Při standardních frézovacích operacích se nemusíte starat o nastavení 
na straně Axis Setup. Tato nastavení se používají pro víceosé obrábění, pojednané v 
lekci 2, "Výroba SolidMill". 
 



Lekce 1   Tradiční SolidMill   37 

 

Výběr materiálu 
Aby mohl ESPRIT automaticky vypočítat podávání a rychlosti pro řezací operace, 
musíte vybrat typ materiálu pro součástku. 
1 V menu Machining vyberte Machining → KnowledgeBase → KnowledgeBase 

Setup. 
 

 
 

2 V dialogovém okně vyberte Aluminum Alloys, Wrought pro třídu materiálů (Material 
Class).  

 

 
3 Nastavte standardní technologii na Standard Default Technology - Inch,Metric, je-

li k dispozici, a pak stiskněte OK.  

Pokud standardní technologie není k dispozici, nechte název nastavený na None. 
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Standardní technologie 
Standardní technologie kontroluje standardní nastavení na stránkách řezného 
nástroje a pracovní technologie. V lekcích v tomto návodu používejte standardní 
systémová nastavení, pokud byla nainstalována na vašem systému.  

Pokud nepoužijete standardní nastavení, ESPRIT vyhledá poslední použití této 
operace a aplikuje příslušná nastavení na aktuální operaci. V takovém případě 
musíte zkontrolovat, zda máte vhodná nastavení, když vytváříte řezné nástroje a 
operace.  

Další informace naleznete v kapitole "Standardní nastavení v Default Process KB 
Manager" na straně 189. 

Poznámka   V této lekci nebudete vybírat typ součástky (Part Type). ESPRIT používá 
typy součástek pro automatizaci obráběcích procesů na bázi dat uložených v 
KnowledgeBase™, což je diskutováno v lekci 8, "KnowledgeBase". 

Výpočty podávání a rychlostí s použitím KnowledgeBaseTM 

Stránky operací SolidMill mají nastavení s názvem "Use Feed and Speed KB". Při 
nastavení na Yes využívá ESPRIT následující informace pro automatické výpočty 
podávání a rychlostí: 

Nastavení KnowledgeBaseTM Stránka nástrojů Stránka operací 
Třída materiálu Typ nástroje Typ řezu 
Stav materiálu Průměr nástroje Krok 
 Materiál nástroje Inkrementální hloubka 

 
Je-li kterékoli z těchto nastavení aktualizováno, ESPRIT automaticky přepočítá 
podávání a rychlosti pro všechny související řezací operace. 
 



Lekce 1   Tradiční SolidMill   39 

 

Vytváření nástrojů 
Než začnete vytvářet frézovací operace, musíte nejprve vytvořit nástroje. Pro čelní 
obráběcí operace potřebujete čelní frézu. Při vrtání otvorů vytváříte dva vývrty - jeden 
pro označení polohy a zešikmení otvorů a druhý pro vrtání - plus závitník pro proříznutí 
otvorů. Rovněž vytváříte čelní válcové frézy o různých průměrech, které se používají k 
hrubování a dokončování kapes a drážek. 
1 V menu vyberte Machining → Milling Tools → Milling Tools , aby se zobrazil 

panel nástrojů. 

 
 

2 Vyberte Face Mill            z panelu 
nástrojů Milling Tools. Zobrazí se 
dialogové okno Face Mill.  
Nastavte následující hodnoty:  

Na stránce Geometry:  
Jednotka  Metrická 

Průměr 50.000 

 

Na stránce General:  

ID nástroje  FM 50 

Nástroj číslo 1 

Mat. Nástr.  karbid, 
indexovatelný, 
nepotahovaný 

Výměna nástrojů 0, 0, 125 
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Přesvědčte se, že jsou ostatní hodnoty nastaveny na vhodné velikosti. Pokud byla 
systémová jednotka dříve nastavena na palce, nemusí se hodnoty aktualizovat na 
příslušné metrické hodnoty. 

3 Stiskněte OK a vytvoří se nástroj. 

Když vytváříte nástroje, jsou přidávány do Project 
Manager. Vyberte kartu Tools, aby se zobrazovaly 
nástroje, když je přidáváte. 

4 Vyberte Drill        .  

Jednotka musí být stále nastavena na metrickou.  

Nastavte následující hodnoty a stiskněte OK: 

Geometrie: 

Průměr    10.000 

Úhel nástroje   90 Tento nástroj bude použit k 
označení vývrtu a zešikmení 
otvorů. 

Všeobecné: 

ID nástroje    SD 10 

Nástroj číslo    2 

Materiál nástr. rychlořezná ocel, plná, nepotahovaná 

Výměna nástr. 0, 0, 125 

5 Znovu vyberte Drill        

Nastavte následující hodnoty a stiskněte OK: 

Geometrie: 

Průměr   4.000 

Úhel nástroje 130 Tento nástroj bude použit k vrtání otvorů. 

Všeobecné: 

ID nástroje   DR 04 

Nástroj číslo   3 
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6 Vyberte Tap         

Nastavte následující hodnoty a stiskněte OK: 

Geometrie: 

Průměr       4.500 
Poznámka   Když stisknete klávesu Tab 

Závit / jednotka 2 po zadání hodnoty Závit / jednotka, bude
  hodnota stoupání automaticky vypočítána. 
Stoupání       0.500 

Všeobecné: 

 

ID nástroje      TD MF04.5 x 0,5 

Nástroj číslo      4 

Výměna nástr.   0, 0, 125 

 

7 Vyberte End Mill         . 

Nastavte následující hodnoty a stiskněte OK: 

Geometrie: 

Průměr    20.000 

Všeobecné: 

ID nástroje     EM 20 

Nástroj číslo     5 

Mater. nástr.    rychlořezná ocel, plná, nepotahovaná 

Výměna nástr. 0, 0, 125 

 

Vytvořte dvě další čelní válcové frézy s použitím následujících nastavení: 

Geometrie:  Geometrie: 

Průměr     7.000 Průměr    6 000  

Všeobecné:   Všeobecné: 

ID nástroje     EM 07 ID nástroje    EM 06 
Číslo nástroje   6 Nástroj číslo     7 

 

Čelní válcová fréza 7mm bude použita při zbývajících obráběcích pracích k 
odstranění přebývajícího materiálu, který zůstal po hrubování. 

Čelní válcová fréza 6mm bude použita k dokončení stěn kapes a k řezání drážek. 

 

 

 

Tento nástroj bude použit k hrubování 
kapes. 
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Nyní máte všechny nástroje, které potřebujete k obrábění této součástky. Každý nástroj 
je uveden v seznamu Project Manager, jak je znázorněno níže. 
 

 
 
Poznámka   Nástroje mohou být uloženy v knihovně nástrojů pro budoucí použití. V 
Project Manager vyberte jeden nebo více nástrojů, které chcete uložit do paměti (při 
výběru několika nástrojů přidržte stisknutou klávesu Shift nebo Ctrl), pak klepněte pravým 
tlačítkem myši a vyberte File → Save. Nástroje se ukládají do paměti ve formě souboru 
knihovny nástrojů (.etl). Chcete-li používat nástroje uložené v knihovně, klepněte pravým 
tlačítkem myši uvnitř stránky Tool a vyberte File → Open.  
Pro zavření panelu nástrojů Milling Tools 
klepněte pravým tlačítkem myši na panel 
nástrojů a zrušte zaškrtnutí Milling Tools. 
Panely nástrojů můžete skrýt nebo zobrazit také 
tak, že vyberete Toolbars z menu View. 
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Vytvoření čelní obráběcí operace 
V závislosti na tom, jestli používáte nastavení standardní technologie, se vaše stránky 
technologie nemusí dokonale shodovat s ilustracemi znázorněnými v této lekci. Účelem 
těchto lekcí je poskytnout vám přehled o tom, jak se vytvářejí různé řezací operace, aniž 
by se u každého nastavení zacházelo do velkých detailů. Jsou zde použita a vysvětlena 
nejvhodnější nastavení pro každou operaci. Další informace o nastaveních, která nejsou 
diskutována v této příručce, naleznete v online nápovědě v ESPRIT (stiskněte klávesu 
F1 nebo tlačítko Help na stránce technologie). 
Nejprve budete obrábět čelo horní části součástky. 
1 V panelu nástrojů SolidMill Traditional vyberte Facing            

Zobrazí se stránka operace. 
2 Na straně General vyberte FM 50 jako ID nástroje (Tool ID). 

 
Pamatujte si, že všechny nástroje, které jste přidali dříve do Project Manager, jsou 
na výběr v rozbalovacím seznamu Tool ID. 
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3 Na stránce Face nastavte Bridge Movement na Arcs a % of Tool na 100 a pak stiskněte 
OK. 
 

 
Bridge Movement ovládá tvar spojovacího prvku mezi každým řezacím 
průchodem. V tomto případě se vytvářejí hladké přechody. 
 
Overhang,% of Tool jsou interaktivní nastavení, která kontrolují, jak daleko 
pojede nástroj za hranu linie. Když zadáte 100 do parametru % of Tool, vypočítá 
se automaticky hodnota Overhang na základě průměru nástroje. V tomto příkladu 
řeže nástroj za hranu o stejnou hodnotu, jako je průměr nástroje. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Lekce 1   Tradiční SolidMill   45 

 

4 V oblasti výzev jste požádáni, abyste vybrali referenční linii (“Select Reference 
Feature”). Na pracovní ploše vyberte linii v blízkosti hranice jako na obrázku. 

 

 
 

Při zapnutém režimu HI se hranice musí zvýraznit jako na obrázku. Pokud ne, 
odpovězte "Ne" stisknutím pravého tlačítka myši. Když se zvýrazní linie hranice, 
odpovězte "Ano" stisknutím levého tlačítka myši. 
 
Dejte pozor, abyste vybrali linii hranice (Boundary) a ne linii součástky (Part). 
Jestliže vyberete linii součástky, ESPRIT neobrobí čelo plochy nad kapsami. 
 
Na pracovní ploše se objeví dráha nástroje a nová operace je přidána do Project 
Manager. 
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Vrtání a proříznutí otvorů 

Dále potřebujete vytvořit vrtací operace pro označení vývrtu a zešikmení každého otvoru a 
pak pro vyvrtání a proříznutí každého otvoru. 

Chcete-li zobrazit vlastnosti obrábění linie otvoru (Hole), 
stiskněte klávesy Alt+Enter, aby se zobrazil Property 
Browser, a pak vyberte linii Hole v Project Manager nebo na 
pracovní ploše.  

K dispozici jsou informace o hloubce a průměru otvoru a 
také o průměru a úhlu úkosu. Rovněž si všimněte, že tyto 
otvory neprocházejí skrz součástku. 

Poznámka   Nástroj, který jste vytvořili dříve pro označení 
vrtací operace (SD 10) má úhel, který je stejný jako úhel 
zešikmení.  

Nejprve označte a zkoste otvory 

1 Vyberte Drilling            z panelu nástrojů SolidMill. 

2 Vyberte SD 10 pro Tool ID. 
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3  Nastavte “Use Chamfer Diameter” na Yes. 
4  Nastavte “Chamfer Diameter” na 6,5 (stejný průměr úkosu jako linie).  

Když je parametr "Use Chamfer Diameter" nastaven na Yes a je zadána 
hodnota průměru úkosu (Chamfer Diameter), používá ESPRIT průměr úkosu 
a úhel nástroje (definovaný na stránce nástroje) pro automatický výpočet 
celkové hloubky (Total Depth). 

5  Napište popis pro název operace. 
Zadání popisného názvu pro operaci usnadňuje rozlišování různých operací 
aplikovaných na jednu součástku. 

6  Stiskněte OK. 
7  ESPRIT vás vyzve, abyste vybrali referenční linii PTOP (“Select Reference 

PTOP Feature”). S použitím režimu HI vyberte linii Hole, jak je uvedeno výše, 
a pak odpovězte "Ano" stisknutím levého tlačítka myši. 

 

 
 
Nová operace je přidána do Project Manager v Operations 
Manager a také ve Feature Manager.  
 
Můžete zobrazit všechny operace v aktuální relaci v 
Operations Manager nebo všechny operace související s 
konkrétní linií ve Feature Manager. 
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Dále potřebujete vyvrtat otvory do dané hloubky, abyste je pak mohli proříznout. 

1 Vyberte Drilling           z panelu nástrojů. 

2 Vyberte DR 04 jako Tool ID. 

3 Nastavte “Use Chamfer Diameter” na No a “Tip Already Included” na No a pak 
nastavte celkovou hloubku (Total Depth) na 10,8. Zadejte název operace a 
stiskněte OK. 

 

 
 

Můžete také napsat podrobnější popis operace do pole Comments.  

Poznámka   Parametr Total Depth se dá měnit, pouze když je parametr "Use 
Chamfer Diameter" nastaven na No. 

4 S použitím režimu HI vyberte linii Hole pro vytvoření vrtací operace. 

Nakonec musíte proříznout otvory. 

1 Znovu vyberte Drilling  . 

2 Nastavte Tool ID na TD MF04.5 x 0,5. 
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3 Nastavte Cycle Type na Tap a Type of Cut na Tapping. 

4 Nastavte Total Depth na 10 a Tip Already Included na No. 

5 Jako název operace (Operation Name) napište “Tap - MF04.5 x 0,5” a 
stiskněte OK. 

6 Vyberte linii Hole pro vytvoření prořezávací operace. 

Vrtací operace musí být uvedeny v seznamu pod linií 
Hole ve Feature Manager jako na obrázku: 

 
 
Obrábění kapes a zbytkové obrábění 
Nejprve musíte hrubovat kapsy a ponechat 1mm nezpracovaného materiálu 
na stěnách. Potom vytvoříte zbytkovou obráběcí operaci, abyste odstranili 
přebývající materiál z rohů každé kapsy. Nakonec dokončíte kapsy jediným 
průchodem podél stěn. 
Abyste snáze rozpoznali nové operace, můžete skrýt obraz operací 
obrábění čela. V Operations Manager klepněte pravým tlačítkem myši na 
operaci obrábění čela a objeví se kontextové menu. 
V menu vyberte 
Suppress.  
 
Operace na 
pracovní ploše 
bude dočasně 
skryta. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



50 Začínáme s Esprit 
 
Nejprve obrobte kapsy nahrubo 20mm čelní válcovou frézou a ponechte 1mm materiálu na 
stěnách. 

1 Vyberte Pocketing            z panelu nástrojů. 

2 Vyberte EM 20 pro Tool ID a nastavte Total Depth na 20 (každá kapsa je 10mm 
hluboká). Přesvědčte se, že je inkrementální hloubka (Incremental Depth) nastavena 
na 20. 

 

 
 

3 Vyberte kartu Common a nastavte Stock Allowance Walls na 1 000. 
4 Stiskněte OK. 
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5 S použitím režimu HI vyberte linii Pocket, jako na obrázku.  

 

Dráha nástroje je generována tak, aby byly řezány horní a spodní kapsy. 

 

Dále musíte s použitím 7mm čelní válcové frézy odstranit přebytečný materiál, 
který zůstal v rozích každé kapsy po 20mm fréze. 

1 Vyberte Rest Machining          z panelu nástrojů. 

2 Nastavte Tool ID na EM 07. 

3 Vyberte kartu Rest Material. 
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4 Nastavte vzdálenost Lead-In/Lead-Out na 8 000 a poloměr Lead-In/Lead-Out na 4,500 

a stiskněte OK. 
 

 
5 S použitím režimu HI znovu vyberte linii Pocket. 
ESPRIT analyzuje materiál 
odstraněný během předcházející 
operace obrábění kapsy a pak 
vypočítává plochy k obrábění. V 
tomto případě jsou vytvořeny 
konturovací průchody pro 
vyčištění rohů. 
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Nyní použijete 6mm čelní válcovou frézu k vytvoření jediného dokončovacího 
průchodu uvnitř každé kapsy pro odstranění nezpracovaného materiálu podél stěn. 

1 V panelu nástrojů vyberte Pocketing         . 

2 Vyberte kartu Rough a nastavte Output Rough Passes na No. 

3 Vyberte kartu Wall Finish a nastavte počet průchodů (# of Passes) na 1; potom 
stiskněte klávesu Tab. Jakmile stisknete klávesu Tab, jsou nastavení Wall 
Finish k dispozici pro vstup. 

4 Nastavte Tool ID na EM 06. 

5 Pro vzdálenost Lead-In/Lead-Out Distance zadejte 6*0,70 a stiskněte klávesu Tab.  

Vzdálenost je vypočítán jako 70% průměru nástroje 6mm nebo 4,200.  

Nastavte poloměr Lead-In/Lead-Out na 6*0,20 a stiskněte klávesu Tab. 

 
6 Stiskněte OK a pak vyberte linii Pocket. 
 

Podél stěn každé kapsy se vytvoří jeden průchod. 
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Nyní se musí objevit Feature Manager jako na obrázku: 

 
 
 
 
Konturování 
Poslední dvě operace jsou konturovací průchody pro řezání dvou drážek. 

1 Vyberte Contouring         z panelu nástrojů. 

2 Nastavte Tool ID na EM 06. 
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3 Nastavte Total Depth na 5. 

4 Nastavte Type of Cut na END MILLING - SLOTTING.  

5 Stiskněte OK a pak vyberte jednu z linií drážek.  
 

 
 
6      Znovu vyberte Contouring  . 

7 Pro druhou drážku budete používat přesně stejná nastavení, takže stačí stisknout 
OK. 

8 Vyberte druhou drážku. 

 

Všechny řezací operace pro tuto součástku jsou nyní hotové.  

Poznámka   Než přejdete k simulaci, musíte zrušit potlačení 
operace obrábění čela. Jinak tato operace nebude simulována. 

1 V Operations Manager klepněte pravým tlačítkem myši na 
operaci obrábění čela. 

2 V menu vyberte Unsuppress. 
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Simulace 

Simulace umožňuje graficky vyzkoušet řezací operace předtím, než generujete NC 
kód. ESPRIT standardně simuluje všechny řezací operace v Operations Manager v 
pořadí, jak se vyskytují v seznamu. V případě potřeby můžete také vybrat pro simulaci 
jednotlivé operace. 

Než začnete simulovat operace v této lekci, musíte definovat velikost a tvar 
nezpracovaného materiálu. 

1 V menu Machining vyberte Simulation. 
Zobrazí se panel nástrojů Simulation. 

2 Vyberte Simulation Parameters z 
panelu nástrojů. 

 

3 Vyberte kartu Solids a 
nastavte hodnoty 
nezpracovaného materiálu 
jako na obrázku:  

4 Stiskněte tlačítko Add.  

Nový tvar nezpracovaného 
materiálu je přidán do 
dialogového okna 
parametrů simulace.  

Když spustíte simulaci, 
zobrazí se tento tvar na 
pracovní ploše. 

5 Stiskněte OK, aby se zavřelo dialogové okno Simulation Parameters. 

6 V panelu nástrojů Simulation vyberte Run, čímž spustíte simulaci.  

 

 
 
Jsou simulovány všechny operace uvedené v Operations Manager. 
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Poznámka   Ikony pro viditelnost nástrojů            a viditelnost držáků         
ovládají, jestli se během simulace zobrazí nástroj, resp. držák. 
 
Kdykoli během simulace můžete stisknout Pause          pro dočasné 
zastavení simulace. Chcete-li pak opět restartovat simulaci, stiskněte Run. 
 
Následující ilustrace znázorňuje simulaci v polovině operace zbytkového 
obrábění. 
 

 
 
Všimněte si, že simulace používá různé barvy, jsou-li použity různé 
nástroje. Barva simulovaného řezu se nastavuje na stránce nástroje. Pro 
snazší rozlišení několika řezacích operací můžete definovat zvláštní 
barvu pro každý nástroj. 

 
7 Když skončí simulace, stiskněte Stop, abyste opustili simulační režim. 
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Generování NC kódu 

Nyní musíte převést všechny řezací operace na NC kód. NC kód se generuje ve 
stejném pořadí, v jakém jsou operace uvedeny v Operations Manager.  
 
Tip  Do NC kódu můžete také převést jen vybrané operace. V Operations Manager 
přidržte stisknutou klávesu Ctrl a vyberte několik operací nebo přidržte stisknutou 
klávesu Shift a vyberte první a poslední z bloku operací. Potom klepněte pravým 
tlačítkem myši na jednu z vybraných operací a vyberte "NC Code" z menu. 
1 V menu File vyberte NC Code  

nebo  
V panelu nástrojů Common Machining vyberte 
NC Code. 

 

 

 

2 V dialogovém okně vyberte formát NC 
stroje. Pokud zde není uveden soubor 
pro váš NC stroj, stiskněte tlačítko 
Browse. 

V případě potřeby můžete také změnit 
název souboru NC kódu. Tento název 
souboru je standardně stejný jako 
aktuální název souboru ESPRIT s tím 
rozdílem, že má příponu souboru .NC. 

3 Stisknutím tlačítka Apply převeďte operace do NC kódu s použitím 
vybraného souboru Machine Format. 
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Kód se zobrazí v okně NC Editor. 
 

 
Je možné revidovat a upravovat kód v tomto okně. Když provedete změny, 
nezapomeňte uložit soubor.  

Tip  V editoru můžete rovněž použít program ESPRIT DNC k přenesení kódu do stroje
pomocí kabelu RS-232. 

Přenos NC kódu do NC stroje 

Je několik způsobů jak přenést soubor NC kódu do NC stroje. 
• Uložte NC soubor na disketu a přeneste disketu do NC stroje vybaveného 

disketovou mechanikou. 

• Použijte program DNC od jiného výrobce. 

• Přeneste NC soubor přes síť nebo bezdrátový systém do stroje, který má 
síťovou kartu a podporuje protokol TCP/IP. 

• S použitím programu ESPRIT DNC přeneste soubor sériovým kabelem RS-
232 připojeným k portu COM na počítači. 
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Používání komunikace ESPRIT 

Abyste mohli odeslat NC kód do NC stroje nebo z něho nějaký kód obdržet, musíte mít 
správně zkonfigurovanou přípojku kabelu RS-232 z portu COM na počítači do NC stroje. 
Rovněž musíte vytvořit nebo okopírovat soubory .SRS (odesílání) a .RRS (příjem), které 
jsou správně zkonfigurovány v adresáři ..\DNC. 

Když vytvoříte NC kód, jak je popsáno výše, uložte soubor a pak: 

1 Vyberte Run WDNC v NC editoru.  
 

 
Zobrazí se okno programu DNC. 

2 Pokud se nezobrazí okna pro soubory .SRS a .RRS, které potřebujete, vyberte Get 
DNC from Archive z menu File. 
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3 Vyhledejte soubory .SRS a .RRS, které potřebujete. Vyberte soubory a stiskněte 
Apply.  

 

 
 

Soubory se automaticky okopírují do adresáře ..\DNC. Všechny soubory .SRS a .RRS 
z adresáře ..\DNC jsou zobrazeny v okně programu DNC. 

4 Stisknutím tlačítka Close zavřete okno archivu. 

Soubory .SRS a .RRS, které jste vybrali z archivu, jsou nyní okna v programu DNC.  
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Chcete-li přidat název souboru do okna SRS nebo RRS, vyberte okno, čímž ho 
aktivujete, a pak vyberte File → Open File. Vyberte NC soubor, který chcete 
odeslat, a stiskněte Open. 

5 Připravte NC stroj na přijetí souboru. 

6 Vyberte okno pro správný soubor .SRS.  

Režim pro soubory .SRS je automaticky nastaven na "send" (odeslat). 

7 Vyberte Run z menu Control. ESPRIT odešle soubor z aktivního okna .SRS. 

Poznámka   ESPRIT odesílá NC kód počínaje vybraným řádkem v okně kódu. 
Chcete-li odeslat celý program, přesvědčte se, že je v okně kódu zvolen první 
řádek kódu jako na obrázku. Pomocí posunovacích tlačítek se můžete přesouvat 
nahoru a dolů v okně kódu.  

 

 

8 Sledujte přenos. V menu Control můžete vybrat Stop, Pause, Reset nebo 
Repeat. 

 



 

 

 

 

 

 

 

Lekce 2

Výroba SolidMill

V této lekci se naučíte, jak obrábět víceosé součástky. Vytvoříte operace 
obrábění čela a vrtání na horní a bočních stranách součástky ilustrované 
níže a pak budete tyto operace graficky simulovat s použitím plného 
modelu. 

 
 

V této lekci se naučíte toto: 

• Připojení souboru CAD     65 

• Vytváření pracovních rovin     66 

• Vytvoření pracovních souřadnic a linií     70 

• Nastavení víceosého stroje     74 

• Otevření knihovny nástrojů     76 

• Vytváření operací obrábění čela     76 

• Simulace     78 
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Tato lekce používá metrické hodnoty. Než začnete s touto lekcí, přesvědčte se, že je 
parametr System Unit nastaven na Metric. V menu vyberte Tools → System Unit → 
Metric. 

1 Vyberte Open         ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor: 
Getting Started\SolidMill\multi_axis_part.esp 

3 Vyberte Open. 

Tento soubor obsahuje plný model rotačního stolu a upínadla. Potom položíte 
CAD model na upínadlo.  

 
 
4 Přesvědčte se, že jsou zapnuté režimy HI a 

SNAP. Stavová oblast v pravém dolním rohu 
obrazovky musí vypadat jako na obrázku vpravo:  
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Připojení souboru CAD 

V této lekci budete spojovat soubor CAD se souborem ESPRIT, který jste právě 
otevřeli. Pro usnadnění práce umístíte CAD model na jinou vrstvu. Když jsou položky 
umístěny ve vrstvách, můžete zobrazit nebo skrýt jakoukoli položku tak, že zapnete 
nebo vypnete její vrstvu. 

1 V rozbalovacím seznamu Layers vyberte vrstvu 9 
'Part' (Součástka). Když připojíte CAD součástku, 
bude umístěna na tuto vrstvu.  

2 Vyberte Open        ze standardního panelu nástrojů. 

3 Zaškrtněte okénko Merge. 

4 Na ESPRIT CD vyberte následující soubor: Getting 
Started\SolidMill\Casting_5_Axis_Part.x_t   

 
Poznámka   Soubor ‘Casting_5_Axis_Stock.x_t’ bude použit později pro účely 
simulace. 
 
5 Vyberte Open. 
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CAD model je vnořen do aktuálního souboru ESPRIT. 
 

 
Vytváření pracovních rovin 

Budete obrábět čela na horní a bočních stranách součástky, takže musíte vytvořit 
pracovní roviny, abyste mohli začít vytvářet linie. Když je vytvořena linie, přiřadí 
ESPRIT aktuální pracovní rovinu jako vlastnost této linii. Pracovní rovina je důležitá, 
protože má vliv na orientaci nástroje, přibližujícího se k součástce během obráběcí 
operace.  

Aktuální pracovní rovina je dána polohou os UVW.  

Chcete-li zobrazit osy UVW, vyberte UVW Axis z menu View.  

 

Poznámka   Osy UVW se standardně zobrazují ve stejném místě a se stejnou 
orientací jako osy XYZ. 
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Nyní vytvoříte pracovní rovinu na předním čele součástky. Rovina UV os UVW musí 
být rovnoběžná s čelem, které budete řezat, takže osa W bude kolmá k čelu. 

1 Aby se vám snáze pracovalo na součástce, 
skryjete obraz rotačního stolu a upínadla. V 
panelu nástrojů Layers and Planes vyberte 
ikonu Layers.  

2 V dialogovém okně zrušte zakšrtnutí vrstev 
Table a Fixture (v okénku vlevo od nich). 

Položky umístěné na těchto vrstvách jsou 
nyní na pracovní ploše dočasně skryté. 

3 V rozbalovacím seznamu View Planes 
vyberte pohled na přední čelo front_face. 

 

Poznámka   Zde jsou pro vás již vytvořeny 
dva individualizované pohledy, front_face 
(přední čelo) a back_face (zadní čelo). 

 

4 V panelu nástrojů Layers and Planes 
vyberte ikonu Work Planes.  

Zobrazí se dialogové okno Work Planes a 
automaticky se otevře panel nástrojů Modify 
Work Planes. 

 

5 V panelu nástrojů Modify Work Planes vyberte From Geometry           
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6 S použitím režimu HI vyberte hranu otvoru 
uprostřed čela, znázorněnou vpravo, a pak 
odpovězte "Ano" stisknutím levého tlačítka myši.  

Poznámka   V případě potřeby použijte ikony 
v panelu nástrojů View Planes k přiblížení a 
pak teprve vyberte hranu.  

 

Soustava UVW je umístěna uprostřed otvoru. V 
tomto případě ukazuje osa W (zobrazená modře) 
špatným směrem.  

Musíte otočit osy UVW o 180 stupňů okolo osy 
V, aby osa W ukazovala směrem od součástky. 

 

7 Vyberte Rotate UVW            z panelu nástrojů Modify Work 
Planes. Budete vyzváni, abyste zadali úhel otočení okolo osy 
U.  

8 Napište 0 a stiskněte klávesu Enter. 

9 Pro úhel otočení okolo osy V zadejte 180. 

10 Pro otočení okolo osy W zadejte 0. 

Osy UVW se musí zobrazit jako na ilustraci vpravo. 
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Uložte tuto pracovní rovinu do paměti pro pozdější použití. 

1 V dialogovém okně Work Planes vyberte New... 

2 Zadejte název nové pracovní roviny a stiskněte OK. 

 
 
Dále musíte vytvořit druhou pracovní rovinu na zadní straně součástky. 

1 V rozbalovacím seznamu View Planes vyberte pohled na zadní čelo back_face. 

2 S použitím režimu HI vyberte hranu otvoru 
uprostřed a odpovězte "Ano". 

 

 

 

 

Pracovní rovina je umístěna uprostřed otvoru. 
Stejně jako předtím ukazuje osa W špatným 
směrem.  

V tomto případě musíte otočit soustavu UVW 
okolo os V a W. 

3 Vyberte Rotate UVW           z panelu 
nástrojů Modify Work Planes. 
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4 Pro otočení kolem osy U zad 0. Pro otočení kolem osy V zadejte 180. Pro otočení 

kolem osy W zadejte -90. Soustava UVW se musí zobrazit jako na ilustraci:  

5 V dialogovém okně Work Planes vyberte New... 

6 Zadejte název nové pracovní roviny a stiskněte OK.  

Nyní máte dvě nové pracovní roviny. 

 

Vytvoření pracovních souřadnic a linií 

Pracovní souřadnice jsou referenční souřadnice polohy, které značně zjednodušují 
programování, když obrábíte několik součástek. Místo referencování řezací operace z 
globálního počátku můžete referencovat z pracovní souřadnice. Tímto způsobem můžete 
vytvořit jedinou řezací operaci a pak ji okopírovat do několika pracovních souřadnic.  

Ačkoli to pro typ součástky použitý v této lekci není nutné, naučíte se nyní, jak vytvářet a 
používat pracovní souřadnice. 

Nejprve vytvoříte pracovní souřadnici a profilovou linii na zadním čele součástky. Pracovní 
rovina, kterou jste právě vytvořili, musí být stále aktivní pracovní rovinou. 

1 Stiskněte Ctrl+M, aby se zobrazilo dialogové 
okno Masks.  

Přesvědčte se, že je zaškrtnutá položka 
Work Coordinates.  

2 V případě potřeby vyvolejte stisknutím 
klávesy F2 Project Manager a vyberte kartu 
Features. 
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3 Klepněte pravým tlačítkem myši uvnitř Feature Manager a vyberte New Work 

Coordinate... 
4 Zadejte název pro novou 

pracovní souřadnici, 
přesvědčte se, že je parametr 
Work Plane nastaven na 'back 
pad' a stiskněte OK.  

Nová pracovní souřadnice je 
přidána do Feature Manager. 
Pracovní souřadnice se rovněž 
zobrazí červeně na pracovní 
ploše.  

5 Ve Feature Manager znamená červený rámeček 
okolo názvu pracovní souřadnice, že se jedná o 
aktivní pracovní souřadnici.  

6 V menu vyberte Create → Features, aby se 
zobrazil panel nástrojů Features. 

7 Vyberte Face Profiles           z panelu nástrojů. 

8 S použitím režimu HI vyberte zadní čelo a 
odpovězte "Ano" stisknutím levého tlačítka 
myši. 

Každá smyčka čela je přidána do seznamu v 
dialogovém okně Profile.  

 

9 Stisknutím OK v dialogovém okně vytvořte linii. 
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Nové linie jsou uvedeny pod novou pracovní souřadnicí, 
kterou jste vytvořili v kroku 4. Tato pracovní souřadnice je 
přiřazena jako vlastnost liniím.  

Dále vytvoříte pracovní souřadnici a profilovou linii pro přední čelo součástky. 

1 V rozbalovacím seznamu View Planes vyberte 
pohled na přední čelo front_face, čímž změníte 
pohled.  

2 Klepněte pravým tlačítkem myši uvnitř Feature 
Manager a vyberte New Work Coordinate... 

3 Zadejte název pro novou pracovní 
souřadnici a nastavte Work Plane 
na front pad.  

4 Stiskněte OK a vytvoří se 
pracovní souřadnice. 

 

 

 

 

5 Znovu vyberte Face Profiles             z panelu nástrojů Features. 

6 S použitím režimu HI vyberte přední čelo a odpovězte "Ano".  

7 Stisknutím OK v dialogovém okně vytvořte linii.  
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Nakonec vytvoříte linii na horním čele součástky. 

1 V rozbalovacím seznamu Work Planes vyberte XYZ, chcete-li aktivovat standardní 
pracovní rovinu. 

2 Ve Feature Manager klepněte pravým tlačítkem myši na pracovní souřadnici 
XYZ a  vyberte Active Work Coordinate z menu. Tím aktivujete standardní 
pracovní souřadnici. 

3 Vyberte Face Profiles            z panelu nástrojů. 

4 S použitím režimu HI vyberte horní čelo součástky a pak stisknutím OK vytvořte linii.  

 

 
Musí se objevit Feature Manager jako na obrázku.  
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Nastavení víceosého stroje 

Tato lekce používá pohyb stolu v 5 osách současně, takže musíte definovat nastavení pro 
primární a sekundární osu pohybu. Při pohybu ve 4 osách musíte definovat pohyb pouze 
pro primární osu. 

1 V menu Machining vyberte SolidMill Traditional → SolidMill Traditional, aby se 
zobrazil panel nástrojů. Tím přepnete ESPRIT do režimu SolidMill. Další informace o 
režimech obrábění naleznete v kapitole “Vytváření standardních frézovacích operací” 
na straně 35. 

2 V menu Machining vyberte Common Machining → Machine Setup.  
 

 
3 Nastavte hodnoty na stránce Origin a vyberte kartu Axis Setup.  

4 Pro primární i sekundární osu nastavte typ os (Axis Type) na Table Simultaneous. 

5 Primární osa se definuje takto: 

Nastavte osový vektor na 1, 0, 0. Tyto hodnoty specifikují směr primární osy, který je 
shodný s osou U. 

Nastavte Lower Angle Limit na -120 a Upper Angle Limit na 120. Tyto hodnoty 
specifikují meze otáčení pro primární osu.  
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6 Sekundární osa se definuje takto: 

Nastavte osový vektor na 0, 0, 1. Sekundární osa se otáčí kolem osy W.  

Nastavte Lower Angle Limit na 0 a Upper Angle Limit na 360. Tato nastavení udávají, 
že dochází k neomezené rotaci okolo sekundární osy. 

 
7 Nastavte Rotary Clearance na 200. Tím nastavíte polohu nástroje, když se stůl otáčí 

mezi řezacími operacemi. 

8 Stiskněte OK. 
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Otevření knihovny nástrojů 

V knihovně nástrojů jsou již vytvořeny a uloženy tři čelní frézy. V této lekci budete 
importovat nástroje z této knihovny nástrojů do aktuální relace. Další informace o vytváření 
frézovacích nástrojů naleznete v kapitole “Vytváření nástrojů” na straně 39. 

1 V Project Manager vyberte kartu Tools, aby se zobrazil Tool Manager (Manager nástrojů). 

2 Klepněte pravým tlačítkem myši uvnitř Tool 
Manager a vyberte File →Open z menu. 

3 V tomto dialogovém okně vyberte následující 
soubor z CD ESPRIT:  

Getting Started\SolidMill\lesson2_tools.etl 
 
 
 
 
 
 
 

4 Vyberte Open.  

Všechny nástroje v knihovně jsou přidány do 
Tool Manager. 

 

Vytváření operací obrábění čela 

Vytvoříte obráběcí operaci pro každé z tří čel na této součástce. Detailní informace o 
standardních frézovacích operacích najdete v kapitole “Vytváření standardních 
frézovacích operací” na straně 35. 

1 Vyberte Facing           z panelu nástrojů SolidMill Traditional. 

2 Na stránce General nastavte Tool ID na FM 100. 

3 Na stránce Face nastavte Bridge Movement na Arcs a % of Tool Overhang na 100. 

4 Stiskněte OK. 
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5¨ Vyberte profilovou linii, která definuje vnější hranici na horním čele, abyste mohli 
vytvořit operaci.  

 

 
 
6  Znovu vyberte Facing           . 

7  Nastavte Tool ID na FM 015 a stiskněte OK. 

8  Vyberte linii na předním čele součástky.  

 
9  Nastavte orientaci na zadní pohled back_face. 

10 Vyberte Facing            

11 Nastavte Tool ID na FM 025 a stiskněte OK. 
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12 Vyberte profilovou linii na zadním čele součástky.  
 

 
Simulace 

Než začnete simulovat operace v této lekci, musíte definovat nezpracovaný materiál. 
Můžete definovat velikost a tvar bloku materiálu nebo můžete použít plný či 
stereolitografický (STL) model. V této lekci budete používat plný model odlitku jako 
simulovaný nezpracovaný materiál. 

1 Stisknutím klávesy F11 vyvolejte dialogové okno Layers. 

2 Zaškrtnutím okének vedle položek 'Table' (Stůl) a 'Fixture' (Upínadlo) zobrazte 
tyto vrstvy. Zrušte zaškrtnutí položky 'Part', abyste skryli obraz součástky. 

 

 
 

Abyste mohli vybrat model odlitku jako simulovaný nezpracovaný materiál, musíte ho 
nejprve importovat. Stejně jako předtím spojíte CAD model odlitku s aktuální 
součástkou. 

1 V rozbalovacím seznamu Layers vyberte vrstvu 8 'Stock' (Nezpracovaný materiál). 

2 Vyberte Open          ze standardního panelu nástrojů. 
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3 Zaškrtněte okénko Merge. 

4 Na ESPRIT CD vyberte následující soubor: Getting 
Started\SolidMill\Casting_5_Axis_Stock.x_t 

5 Vyberte Open pro spojení CAD modelu se součástkou ESPRIT. 

Dále vytvoříte s použitím odlitku simulovaný nezpracovaný materiál. 

1 V menu Machining vyberte Simulation. Zobrazí 
se panel nástrojů Simulation. 

2 Vyberte Simulation Parameters z panelu nástrojů. 

 

 

 

3 Vyberte kartu Solids a nastavte Type na Stock a Create From na Solid. 

4 Klepněte na výběrovou šipku a s použitím režimu HI vyberte plný model odlitku.  

5 Vyberte okénko vedle parametru Color a nastavte barvu simulace na světle 
šedou. 

 

 

 

 

 

 

 

 

 

 

 

 

Poznámka   Všimněte si, že upínací blok a každá komponenta otočného stolu jsou již 
definovány pro simulaci. 
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6 Stiskněte tlačítko Add a pak stisknutím OK zavřete dialogové okno.  

7 Vyberte Run          z panelu nástrojů Simulation.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 

 

 

 

 

 

Lekce 3

SolidMill FreeForm

Tato lekce vás naučí různým technikám hrubování a dokončování vložky formy 
zobrazené níže. Budete aplikovat obráběcí operace na plný model a používat STL 
modely, které znázorňují zbývající nezpracovaný materiál z předchozích operací.  

V této lekci se naučíte toto: 

• Vytvoření hrubovací operace     84 

• Vytvoření STL linie     86 

• Uložení nezpracované STL součástky     93 

• Import nezpracované STL součástky     93 

• Vytváření dokončovacích operací úrovně Z     96 

• Vytváření dokončovacích operací     101 
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Tato lekce používá metrické hodnoty. Než začnete s touto lekcí, přesvědčte se, že je parametr 
System Unit nastaven na Metric. V menu vyberte Tools → System Unit → Metric. 

V této lekci otevřete existující soubor ESPRIT, který obsahuje plný model vložky formy. 
Nastavení stroje je hotové a frézovací nástroje jsou již vytvořeny. 

1 Vyberte Open           ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor: 
\Getting Started\SolidMill\mold_insert.esp 

3 Změňte na pohled Isometric a vyberte Shaded            z panelu nástrojů View. 

4 Přesvědčte se, že jsou zapnuté režimy HI a SNAP.  
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5   V menu vyberte Machining → SolidMill FreeForm → SolidMill FreeForm. 

 
 
 

6  V menu Machining vyberte Machining → KnowledgeBase → KnowledgeBase Setup. 

7  Vyberte Tool Steels, Wrought - Mold jako materiál součástky (Part Material) a stiskněte 
OK. 

8  Nastavte standardní technologii na Standard Default Technology - Inch,Metric, 
je-li k dispozici, a pak stiskněte OK.  

 
Pokud standardní technologie není k dispozici, nechte název nastavený na None. 
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Chcete-li se dozvědět více o standardní technologii a o tom, jak vybraný materiál 
součástky ovlivňuje automatický výpočet rychlostí a podávání, přečtěte si stranu 38. 

 

Vytvoření hrubovací operace 

V závislosti na tom, jestli používáte nastavení standardní technologie, se vaše stránky 
technologie nemusí dokonale shodovat s ilustracemi znázorněnými v této lekci. Účelem 
těchto lekcí je poskytnout vám přehled různých obráběcích operací. Jsou zde použita a 
vysvětlena nejvhodnější nastavení pro každou operaci, aniž bychom zacházeli do velkých 
podrobností o jednotlivých nastaveních. Další informace o nastaveních, která nejsou 
diskutována v této příručce, naleznete v online nápovědě v ESPRIT (stiskněte klávesu F1 
nebo tlačítko Help na stránce technologie). 

1 Vyberte Roughing           z panelu nástrojů SolidMill FreeForm. 

2 Vyberte EM28 jako Tool ID. Přesvědčte se, že je parametr Stock Allowance nastaven na 1,0. 

Nastavte Entry Mode na Lateral a zadejte 20 jako boční vzdálenost. Následkem toho 
bude nástroj před řezáním v každé inkrementální hloubce podáván ze strany. 
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Název operace: Můžete zadat popisný název pro operaci. Tím si usnadníte zjišťování, 
co která operace provádí, bude-li probíhat několik obráběcích operací na jedné 
součástce. 

3 Vyberte kartu Rough a nastavte Tool Motion Pattern na Zigzag.   
 

Pro inkrementální hloubku (Incremental Depth) zadejte 5,0. Nastavte Bi-Directional na 
Smooth. 
 
Nastavte Finish Contouring na Islands & Boundary. Bude vytvořen konturovací 
průchod kolem každého ostrova a podél hranice po každém inkrementálním 
hrubovacím průchodu; offset daný tloušťkou nezpracovaného materiálu. 
 
Zadejte 2 pro Upper Z Limit a -35 pro Lower Z Limit. Hrubovací průchody budou 
omezeny do těchto limitů.  

 
 
 
 
 
4 Stiskněte OK. 
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5 Vyberte plný model. 

6 Vyberte Cycle Stop,          abyste 
ukončili výběrový proces.  

 

První hrubovací operace je vytvořena.  

Vytvoření STL linie 

STL linie je srovnání mezi materiálem odstraněným během předchozích obráběcích 
operací a aktuální součástkou. STL linie se skládá z tisíců drobných sousedících 
trojúhelníků, které aproximují tvar zbývajícího materiálu. STL linie se dá používat pro 
úsporu času obrábění, je-li definována jako povrch nezpracovaného materiálu. ESPRIT pak 
pouze vytvoří řezací průchody v místech, kde zbývá materiál. 
1 Změňte vrstvu na Stock1.  

 
Tím vytvoříte STL linii na samostatné vrstvě. 
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2  Stiskněte Ctrl+M a zaškrtněte Features.  
Vyberete řetězcovou linii pro definování 
hranice vyhledávání STL linie. 

3  V Project Manager nebo na pracovní ploše vyberte hrubovací operaci. 

4  Vyberte STL Feature           z panelu nástrojů SolidMill FreeForm. 

5  V dialogovém okně zadejte 0 pro 
Z Top a -35 pro Z Bottom.  

Nastavte Grid Value na 0,2. 
Mřížková konstanta (Grid Value) 
reguluje hustotu 
aproximovaných trojúhelníčků. 
Čím nižší hodnota, tím větší 
počet trojúhelníčků. 

Vyberte šipku vedle hodnoty 
Boundary a pak vyberte vnější 
hraniční linii na pracovní ploše. 

6  Stiskněte OK. 
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ESPRIT zpracuje STL linii. Zpracování 
může trvat určitou dobu, v závislosti na 
vašem počítači a počtu vypočítávaných 
trojúhelníčků.  

Poznámka   Pro ilustrační účely není 
vyobrazena dráha hrubovacího nástroje. 
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Dále musíte vytvořit hrubovací operaci, která bude brát v úvahu pouze materiál mezi 
STL linií, kterou jste právě vytvořili, a aktuální součástkou. 

1 V rozbalovacím seznamu Layers nastavte vrstvu zpět na standardní (Default).  

2 Vyberte Roughing            z panelu nástrojů SolidMill FreeForm. 

3 Vyberte EM12 jako Tool ID.  

Změňte Stock Allowance na 0,50 a Lateral Distance na 10.  

Aktualizujte název operace. 
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4 Vyberte kartu Rough a nastavte Tool Motion Pattern na Offset. 
Změňte Incremental Depth na 2,0. Nastavte Finish Contouring na 
Off.  

5 Vyberte kartu Advanced a nastavte Use Secondary Entry na Yes. Přesvědčte se, že 
je parametr Entry Mode nastaven na Plunge.  

Nástroj se pokusí použít vstupní režim nastavený na stránce General pro každou 
inkrementální hloubku. Když nástroj nemůže obrobit oblast s použitím primárního 
vstupního režimu, přepne se na sekundární vstupní režim. V takovém případě použije 
nástroj při řezání dutin ve vložce formy ponořovací pohyby. 

6 Stiskněte OK. 

Zobrazí se dialogové okno s dotazem, jestli chcete použít 
standardní povrchy.  

7 Odpovězte No, protože vyberete STL linii jako nezpracovaný 
materiál.  
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8  Klepněte pravým tlačítkem 
myši na pracovní ploše a 
vyberte Stock Surface z 
kontextového menu.  

9  S použitím režimu HI vyberte 
STL linii.  

10  Znovu klepněte pravým 
tlačítkem myši na pracovní 
ploše a vyberte Part Surface. 
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11 S použitím režimu HI vyberte plný 
model. 

12 Vyberte Cycle Stop,         pro 
generování drah nástrojů.  

Poznámka   Pro ilustrační účely je 
zobrazena pouze druhá hrubovací 
operace. 
Pamatujte si, že obráběcí průchody 
jsou generovány pouze mezi 
specifikovaným nezpracovaným 
materiálem a součástkou.  

13 Vyberte ikonu Layers a zrušte zaškrtnutí Stock1, 
abyste skryli obraz STL linie.  
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Uložení nezpracované STL součástky 

Další možností jak ušetřit čas je použít simulaci k definování nezpracovaného 
materiálu. Po simulování operací můžete uložit simulovaný nezpracovaný materiál 
jako STL model a vybrat tento model jako nezpracovaný povrch pro další obráběcí 
operaci.  

1 Z menu vyberte Machining → Simulation. 

2 Stisknutím tlačítka Run simulujte dvě hrubovací operace.   

3 Z menu vyberte Machining → Advanced Simulation. 
4 Vyberte Save as STL... z panelu nástrojů Advanced Simulation.  

 

5 Uložte STL součástku pod názvem Lesson3_stock.stl.  

6 Vyberte Stop             z panelu nástrojů Simulation. 

 

Import nezpracované STL součástky 

1 V rozbalovacím seznamu Layers vyberte 
Stock 2. Tím umístíte STL model na 
samostatnou vrstvu. 

2 V menu vyberte File → Open a přesvědčte se, že je zaškrtnutá možnost Merge. 

3 Otevřete STL soubor, který jste právě vytvořili. 
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STL model se spojí s plným modelem. Při vytváření příští hrubovací operace vyberete 
STL model jako nezpracovaný povrch a plný model jako cílovou součástku. Dráhy 
nástroje jsou generovány pouze mezi nezpracovaným materiálem a součástkou.  

1 V rozbalovacím seznamu Layers vyberte Default.  

2 Vyberte Roughing    z panelu nástrojů SolidMill FreeForm. 

3 Vyberte EM06 jako Tool ID.  

Změňte Stock Allowance na 0,20 a Lateral Distance na 4. Aktualizujte název 
operace.  
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4 Vyberte kartu Rough a zadejte 0,85 pro Incremental Depth.  

5 Stiskněte OK. 

6 V dialogovém okně Previous Operation vyberte No. 

7 Klepněte pravým tlačítkem myši a 
vyberte Stock Surface, pak 
vyberte STL model s použitím 
režimu HI.  

8 Klepněte pravým tlačítkem myši a 
vyberte Part Surface, pak vyberte 
plný model. 

9 Vyberte Cycle Stop,  .  
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Obráběcí průchody jsou vytvořeny mezi 
vybraným nezpracovaným materiálem a 
plným modelem. Hrubovací operace jsou nyní 
hotové.  

10 Vyberte ikonu Layers a zrušte 
zaškrtnutí Stock2, abyste skryli obraz 
STL modelu. 

Vytváření dokončovacích operací úrovně Z 

Vytvoříte dvě dokončovací operace úrovně Z. Nejprve budete obrábět svislé stěny. Potom 
budete obrábět vodorovné a téměř vodorovné plochy. 

1 Vyberte Z-Level Finishing            z panelu nástrojů SolidMill FreeForm. 

2 Vyberte EM04 jako Tool ID. Nastavte Stock Allowance na 0. 
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Nastavte Entry Mode a Exit Mode na Tangent Radius Horizontal a zadejte 3 pro 
Tangent Radius a the Tangent Distance.  

Tangent Radius Horizontal způsobuje, že se nástroj pohybuje podél tečny oblouku k 
dráze nástroje a ve vodorovné rovině, která prochází prvním bodem dotyku. Toto 
nastavení se běžně používá pro dokončování úrovně Z. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 



98   Začínáme s Esprit 

3 Vyberte kartu Z Level Finish a zadejte Incremental Depth 0,5.  

Nastavte Boundary Contour na Part Profile a zadejte Profile Offset % 50.  

Nastavte Top Z Limit na 0 a Bottom Z Limit na -35.  

Nastavte Cut Horizontal Areas na No.  

 
Boundary Contour se používá k omezení dráhy nástroje do definovaných hranic. Part 
Profile omezuje dráhu nástroje podél vnějšího profilu součástky. Nástroj centruje stroj k 
profilu, aniž by šel za něj. Profile Offset % reguluje vzdálenost offsetu profilu jako 
procentuální část poloměru nástroje. 

4 Vyberte kartu Advanced a nastavte All Contours Closed na No.  

Nastavte Fast Processing na Yes.  

 
Fast Processing urychluje vytváření dráhy nástroje a přitom zachovává přesnost 
součástky. ESPRIT místo použití použití skutečných povrchů aproximuje povrchy jako 
drobné sousedící trojúhelníčky. Polohy nástroje se pak vypočítávají z normál k těmto 
trojúhelníčkům a to zkracuje dobu zpracování. 
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5  Stiskněte OK a pak vyberte No v dialogovém okně Previous Operation. 

6  Vyberte plný model a potom vyberte Cycle Stop           

Obráběcí průchody jsou generovány 
pouze na svislých stěnách. 

Nyní budete obrábět vodorovné plochy. 

1 Vyberte Z-Level Finishing           . 

2 Přesvědčte se, že je parametr Tool ID nastaven na EM04. 

3 Změňte Entry Mode a Exit Mode na Vertical.  
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4 Vyberte kartu Z Level Finish a nastavte Cut Horizontal Areas na Only.  

Pro Max. Slope Angle zadejte 15 a nastavte Tool Motion Pattern na Offset.  

Změňte % of Diameter na 35 a stiskněte klávesu Tab. Automaticky se vypočítá 
vzdálenost Step Over.  

 

 

 

 

 

 

 

 

5 Stiskněte OK a pak vyberte Yes v dialogovém okně Previous Operation. 

6 Vyberte Cycle Stop,            pro 
generování vodorovných řezacích 
průchodů.  
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Vytváření dokončovacích operací 

Dále budete vytvářet dokončovací operace s použitím linií, které omezí řezací 
průchody do definované hranice. 

1 Stisknutím Ctrl+M vyvolejte dialogové okno Masks a zaškrtněte Features, 
aby všechny linie byly zobrazeny na pracovní ploše. 

2       Vyberte Finishing           z panelu nástrojů SolidMill FreeForm. 

3 Vyberte BM02 jako Tool ID.  
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4 Vyberte kartu Finish a nastavte Bi-Directional na Smooth. 

Nastavte Boundary Contour na Feature. Nastavte Profile Offset % na 100 a Terminal Type na  
Normal.  

Terminal Type ovládá polohu nástroje na začátku a na konci řezacích průchodů. 
Normálně začíná řezací průchod v prvním bodě, kde se nástroj dotkne povrchu, a končí 
v posledním možném bodě dotyku.  

5 Stiskněte OK. 

6 Vyberte profilovou linii na levém čele 
vložky formy.  

7 Až budete vyzváni, abyste vybrali 
referenční linii ostrova, klepněte pravým 
tlačítkem myši. 

8 V dialogovém okně Previous Operation 
zvolte Yes, čímž vyberete standardní 
povrchy. 

9 Vyberte Cycle Stop,  .  
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Dokončovací průchody jsou vytvořeny jen 
uvnitř vybrané linie. Pokud leží linie nad 
povrchem, je hranice projektována ve 
směru Z na povrch.  
 
S použitím stejných kroků vytvořte další 
dokončovací operace pomocí dalších hranic 
linií. 
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Lekce 4

SolidTurn

Tato lekce vysvětluje, jak obrábět standardní soustruženou součástku s použitím 
operací SolidTurn. Naučíte se, jak hrubovat, konturovat a vytvářet kapsy na vnějším 
průměru součástky a jak řezat drážky na vnějším průměru a na čele součástky. 

V této lekci se naučíte toto: 

• Vytváření řetězcových linií     107 

• Nastavení soustruhu     111 

• Otevření knihovny nástrojů     115 

• Vytváření standardních soustružnických operací     116 

• Simulace soustružnických operací     129 
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Tato lekce používá metrické hodnoty. Než začnete s touto lekcí, přesvědčte se, že je 
parametr System Unit nastaven na Metric. V menu vyberte Tools › System Unit › Metric. 

V této lekci budete otevírat existující soubor ESPRIT. 

1 Vyberte Open             ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor: 
Getting Started\SolidTurn\Turn_part.esp 

3 Přesvědčte se, že jsou zapnuté režimy HI a SNAP. 
Stavová oblast musí vypadat jako na ilustraci vpravo. 

4 Změňte rovinu pohledu na pohled shora (Top).  

Tento soubor obsahuje plný model hotové součástky. V této lekci budete pracovat s 
geometrií a liniemi. V ESPRIT můžete dočasně skrýt obraz plného modelu, což usnadňuje 
práci na vnitřní geometrii. 

1 V menu vyberte View → Masks nebo stiskněte Ctrl+M, aby se zobrazilo dialogové okno 
Masks. 

2 Zrušte zaškrtnutí Solid.  
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Vytváření řetězcových linií 

Pro většinu soustružnických operací musíte vybrat řetězcovou linii, která popisuje 
počáteční místo, směr řezání, tvar a koncové místo pohybu nástroje. 

Nejprve vytvoříte linii pro hrubovací operaci na vnějším průměru. 

1 V menu vyberte Create → Features, aby se zobrazil panel nástrojů.  

 

2 Vyberte Auto Chain           z panelu nástrojů Features. 

3 S použitím režimu SNAP vyberte počáteční bod jako na obrázku. 

4 Vyberte segment jako na obrázku. Tato linie bude ignorovat drážky na vnějším průměru. 

Poznámka   Dejte pozor, abyste vybrali segment v místě mimo SNAP. Jinak si ESPRIT 
bude myslet, že vybíráte koncové místo řetězce. 

5 Vyberte koncový bod.  
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Všechny prvky mezi prvním a posledním jsou přidány k řetězci.  

6 Vyberte Cycle Stop,           z panelu nástrojů Edit. 

Dále vytvořte linie pro drážky na vnějším průměru. Abyste si 
usnadnili vybírání, použijte ikony Zoom na panelu nástrojů View 
a změňte velikost okna.  

1 Vyberte Auto Chain           z panelu nástrojů. 

2 Vyberte počáteční místo. 

3 Vyberte první prvek v řetězci (v místě mimo SNAP). 

4 Vyberte poslední prvek v řetězci. 

4 3 2 

5 Vyberte Cycle Stop,  . 
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6 Opakujte kroky 2 až 5 a vytvořte linii pro druhou drážku na vnějším průměru.  

Dále vytvořte linii pro operaci obrábění kapsy na vnějším průměru. 

1  Vyberte Auto Chain         z panelu nástrojů. 

2 Vyberte počáteční místo. 

3 Vyberte první prvek v řetězci (v místě mimo SNAP). 

Poznámka   Použijte režim HI, aby bylo jisté, že vybíráte oblouk a ne řetězcovou 
linii. 

4 Vyberte poslední prvek v řetězci (v místě mimo SNAP).  

 
 
 
 
 
 
 
5 Vyberte Cycle Stop,  . 
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Dále vytvoříte linie na čele součástky. První linie bude použita k obrysování čela a 
druhá linie pro operaci drážkování čela. 

1 Vyberte Auto Chain           z panelu nástrojů.  

2 Vyberte počáteční místo. 

3 Vyberte první prvek v řetězci. 

4 Vyberte koncový bod. 

5 Vyberte Cycle Stop,  . 

4 
6 Vyberte Manual Chain           z panelu 

nástrojů.  
7 Vyberte body segmentu SNAP jako na obrázku 

vpravo.  

8 Vyberte Cycle Stop,  . 2 1 

3 4 

Linie pro tuto lekci jsou nyní hotové.  
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Nastavení soustruhu 
V menu Machining vyberte SolidTurn → SolidTurn, aby se zobrazil panel nástrojů. 
Tím se dostanete do režimu SolidTurn. Chcete-li se dozvědět více o režimech 
obrábění, přečtěte si stránku 35. 

Při standardním soustružení potřebujete definovat jen jednu otočnou hlavu a jedno 
vřeteno. Informace o nastavení stroje pro frézovací, resp. soustružnické operace 
najdete v kapitole "Nastavení frézy / soustruhu" na straně 132. Informace o 
komplexnějších nastaveních soustruhů jsou uvedeny v kapitole "Pokročilé techniky 
SolidTurn" na straně 143. 
 

1 V menu Machining vyberte Machining → Common Machining → Machine Setup. 
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2 Definujte typ a velikost nezpracovaného materiálu: 
Nastavte Stock Type na Bar. 

Nastavte Bar Diameter na 36, Maximum Diameter na 51, Total Bar Length na 150 a 
Part Stock Length na 50. 

Nastavte Start Position Z na 0,1.  
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3 Vyberte kartu Turrets a přesvědčte se, že je parametr Turret Type nastaven na Index.  

Definujte Rapid Rate a Max. Feedrate.  

Definujte přípustný pohyb otočné hlavy v osách Z a X. V této lekci se nemusíte starat o 
pohyb v osách Y nebo B. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Otočná hlava má standardně šest stanic nástrojů. Přidávat nástroje budete později v 
této lekci. 

4 Vyberte Turret Definition a nastavte Turret Diameter na 220 a Turret Width na 42.  

 
 
 
 
 
 
Tyto hodnoty ovládají zobrazení otočné hlavy na pracovní ploše a během simulace. 
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5 Vyberte kartu Spindles a přesvědčte se, že je parametr Chuck Type nastaven na OD.  

6 Vyberte Movement Setup. V této lekci se nepoužívá žádný pohyb ve vřetenu, takže 
pohyby Z a X musí být nastaveny na None. Nastavte Z Home Position na -63. 

7 Stiskněte OK. 
Nastavení stroje je hotové. Obrysy otočné hlavy a tyčového materiálu jsou zobrazeny na 
pracovní ploše. Nyní můžete přidávat nástroje a vytvářet soustružnické operace. 
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Otevření knihovny nástrojů 

V této lekci budete používat standardní soustružnický nástroj pro hrubování a 
konturování, jeden drážkovací nástroj pro drážky na vnějším průměru a další pro drážky 
na čele a nástroj s plným poloměrem pro operace soustružení kapes. Tyto nástroje jsou 
již vytvořené a uložené v knihovně nástrojů. 
 
1 Stisknutím klávesy F2 vyvolejte Project Manager. 
2 Vyberte kartu Tools.  

Pamatujte si, že otáčecí nástrojová hlava a stanice definované v nastavení stroje 
(Machine Setup) jsou zobrazeny v Tool Manager. 

3 Klepněte pravým tlačítkem myši kdekoli uvnitř Tool Manager a vyberte  
Open Tool Library. 

4 Vyberte následující soubor z CD ESPRIT:  

Getting Started\SolidTurn\lesson4_tools.etl 

 

5 Vyberte Open pro přidávání nástrojů do aktuální relace.  
 

Když jsou vytvářeny soustružnické nástroje, jsou 
přiřazeny určité stanici. Když přidáváte nástroje z 
knihovny nástrojů, přidává ESPRIT každý nástroj k 
příslušné stanici na základě ID stanice 
specifikovaného pro každý nástroj. 
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Vytváření standardních soustružnických operací 

Nejprve budete hrubovat vnější průměr součástky a konturovat čelo. Pak vyřežete dvě 
drážky na vnějším průměru a vytvoříte operaci obrábění kapsy na vnějším průměru. 
Skončíte řezáním drážky na čele. 

Výběr materiálu 
Aby mohl ESPRIT automaticky vypočítat podávání a rychlosti pro řezací operace, musíte 
vybrat typ materiálu pro součástku. 
 
1 V menu Machining vyberte KnowledgeBase → KnowledgeBase Setup. 

 

2 V dialogovém okně vyberte Aluminum Alloys, Wrought pro třídu materiálů (Material 
Class) a stiskněte OK. 
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Hrubování vnějšího průměru 

Nejprve budete hrubovat vnější průměr součástky.  

1 Vyberte Roughing           z panelu nástrojů SolidTurn. 

2 Pro nástroj (Tool) vyberte OD Insert z rozbalovacího seznamu.  

Zadejte 36 pro Stock Diameter (stejný průměr jako tyčový materiál). 

Stock Diameter definuje konstantní hodnotu průměru materiálu. ESPRIT používá tuto 
hodnotu k vypočítání počtu hrubovacích průchodů, které budou zapotřebí. Je-li materiál 
litý a ne tyčový, můžete zaškrtnout Casting Feature. Když opustíte stránku operace, 
ESPRIT vás vyzve, abyste vybrali linii definující profil odlitku. 
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3 Vyberte kartu General a přesvědčte se, že je parametr Type of Work 
nastaven na OD. 

Pro zaváděcí pohyb nastavte Tangent Distance na 5.  

Nastavte Exit from Lead-Out na X then Z a zadejte 38 jako hodnotu X Clearance Absolute.  

Exit from Lead-Out kontroluje pohyb nástroje do polohy výměny nástrojů. V tomto 
případě nástroj rychle přejde v ose X na hodnotu X Clearance Absolute a pak v ose Z 
na hodnotu Z Clearance Absolute. 
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4 Vyberte kartu Rough a nastavte Clearance Mode na Along Cut. Přesvědčte se, že 
má parametr Clearance Along Cut hodnotu 1. 

Zadejte 2 pro Depth of Cut. 

 

Parametry Rough Stock X a Z musí být nastaveny na 0. 
 
Clearance Mode kontroluje velikost a směr tolerance přidané na začátku každého 
hrubovacího průchodu. Při nastavení na Along Cut se hodnota tolerance měří podél 
každého řezacího průchodu. Při nastavení na Depth se tolerance měří od každého 
následného hloubkového řezu. 

5 Stiskněte OK. 
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6 S použitím režimu HI vyberte linii pro hrubovací operaci jako na ilustraci. Když se 
zvýrazní správná linie, odpovězte "Ano" stisknutím levého tlačítka myši.  

Hrubovací operace je vytvořena a přidána do Project Manager.  

Konturování 
Dále vytvoříte konturovací operaci pro řezání profilu podél čela součástky. 

1 Vyberte Contouring          z panelu nástrojů SolidTurn. 

2 Vyberte OD Insert pro nástroj (Tool). 
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3 Vyberte kartu General a nastavte Type of Work na Face.  

Pro zaváděcí pohyb zadejte 5 pro Tangent Distance.  

Nastavte Lead-Out Type na Z Offset. Z Offset způsobí, že se nástroj bude během 
vysouvání pohybovat rovnoběžně s osou z (vodorovně). Parametr Z Offset Distance je 
automaticky nastaven na 5, stejnou vzdálenost jako zaváděcí pohyb.  

4 Vyberte kartu Contour a přesvědčte se, že je parametr Finish Stock nastaven na 0. 

 

5 Stiskněte OK. 
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6 S použitím režimu HI vytvořte operaci tak, že vyberete konturovou linii na čele 
součástky.  

 
 
 
Drážkování 

Dalším krokem je vyřezat dvě drážky na vnějším průměru součástky. 

1 Vyberte Grooving           z panelu nástrojů SolidTurn. 

2 Vyberte OD Groove jako nástroj (Tool).  

Zadejte 26 pro Stock Diameter.  
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3 Vyberte kartu General a přesvědčte se, že je parametr Type of Work nastaven na OD. 

Nastavte Type of Cut na Boring. 

Nastavte toleranci (Clearance) pro zaváděcí a vysouvací pohyby na 1. 

4 Vyberte kartu Groove a nastavte Groove Type na Standard Variable Step.  

Nastavte Step Over na 0,50 a Clearance na 0,50. 

Pro dokončovací průchody nastavte Type of Cut na Boring.  

 

Standard Variable Step vypočítává na základě tvaru drážky počet průchodů a 
přechodovou vzdálenost pro každý průchod. Přechodová vzdálenost se může měnit, 
ale nikdy nepřekročí hodnotu zadanou v parametru Step Over. 
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5 Stiskněte OK a potom vytvořte operaci tak, že vyberete linii drážky nejbližší k čelu 
součástky.  

Druhá drážka používá přesně stejná nastavení operace jako první, takže stačí okopírovat 
drážkovací operaci z jedné linie do druhé. 

1 V Project Manager vyberte kartu Features. 

2 Přidržte stisknutou klávesu Ctrl a s použitím myši přetáhněte 
drážkovací operaci z první linie drážky do druhé.  

 
 
 
 
 
 
 
 
Nastavení z vybrané operace jsou okopírována a aplikována 
na vybranou linii.  
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Drážkování vnějšího průměru je nyní hotové.  

Obrábění kapsy na vnějším průměru 

Dále potřebujete obrábět kapsu na ploše vnějšího průměru, zanechané hrubovacími 
průchody. 

1 Vyberte Pocketing            z panelu nástrojů SolidTurn. 

2 Vyberte OD Pocket jako nástroje (Tool) a nastavte Stock Diameter na 30. 

3 Vyberte kartu General a přesvědčte se, že je parametr Type of Work nastaven na 
OD. 

Nastavte Lead-In Type na X Offset a X Offset Distance na 1. Parametr 
Lead-out automaticky převezme stejná nastavení. 

Nastavte Exit from Lead-Out na X then Z a zadejte 45 pro X Clearance Absolute. 
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4 Vyberte kartu Pocket a nastavte Clearance Mode na Depth. Zadejte 3 pro Depth of 
Cut. Nastavte Finish Pass na Yes.  

5 Stiskněte OK a pak vyberte linii kapsy.  

Operace obrábění kapsy je vytvořena.  
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Drážkování čela 

Posledním krokem je vyřezat drážku na čele součástky. 

1 Vyberte Grooving           z panelu nástrojů SolidTurn. 

2 Vyberte Face Groove jako Tool a zadejte 0,16224 pro Stock Diameter. 

3 Vyberte kartu General a nastavte Type of Work na Face.  

Protože drážkujete čelo, nastavte Exit from Lead-Out na Z Only a Lead-Out Type na  

Z Offset.  

 

 

 

 

 

 

 

 

 

 

4 Vyberte kartu Groove a nastavte Groove Type na Horizontal Peck.  

Nastavte Step Over na 1,0, Peck Increment na 1,0 a Full Retract IDepth na 0,50. 
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Horizontal Peck vytváří sousedící hloubkové průchody s použitím hodnot Step Over a 
Peck Increment. 

5 Stiskněte OK a vyberte linii definující drážku v čele.  

Poznámka   Tato linie prodlužuje vzdálenost za osu součástky, takže nástroj kompletně 
vyřeže drážku. Jinak může zůstat uprostřed drážky malý důlek jako důsledek poloměru 
nástroje.  

Všechny soustružnické operace jsou nyní hotové.  
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Simulace soustružnických operací 

1 Z menu vyberte Machining → Simulation. 

2 Změňte pohled na simulation.  

3 V panelu nástrojů vyberte Run  .  

Všimněte si, že každý nástroj používá odlišnou barvu simulace. To usnadňuje 
rozpoznávání rozdílů mezi řezy do materiálu jednotlivými nástroji. Barva simulovaného řezu 
se nastavuje na stránce nástroje. 

4 Až simulace skončí, stiskněte Stop,  čímž ukončíte simulační režim. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 



130   Začínáme s Esprit 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lekce 5 

SolidMillTurn 

Tato lekce popisuje, jak vytvořit v ESPRIT řezací operace s osou C (rotace 
okolo materiálu), osou Y (pohyb nástroje) a osou B (rotace nástroje) pro 
frézovací, resp. soustružnické aplikace. Součástka vyobrazená níže je 
příkladem vysoustruženého obrobku, vyžadujícího frézování na průměru 
součástky stejně jako frézovací a vrtací operace na zkosených povrchách, 
které vyžadují otáčení nástroje. 

V této lekci se naučíte toto: 

• Nastavení frézy / soustruhu     132 

• Vytváření konturovacích operací v ose C     135 

• Vytváření konturovacích operací v ose B     141 

 
 
 

 

 



132   Začínáme s Esprit 

Tato lekce používá metrické hodnoty. V menu vyberte Tools → System Unit → Metric.  

V této lekci budete otevírat existující soubor ESPRIT. Nastavení stroje je hotové a nástroje 
jsou již vytvořeny. 

1 Vyberte Open           ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor: 
Getting Started\SolidTurn\MillTurn_part.esp 

3 Přesvědčte se, že jsou zapnuté režimy HI a SNAP. 

 

Nastavení frézy / soustruhu 

Nastavení stroje pro tuto součástku je již hotové. V této lekci se používá jedna otočná 
nástrojová hlava a jedno vřeteno. 

V menu Machining vyberte Machining → Common Machining → Machine Setup.  

Na stránce Turrets je definován přípustný pohyb otočné nástrojové hlavy pod 
parametrem Movement Setup. V této lekci provádí otočná nástrojová hlava kromě 
standardního pohybu v osách X a Z ještě příčný (osa Y) a rotační pohyb (osa B). 
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Nastavení osy B v nastavení stroje (Machine Setup) se používají v kombinaci s pracovní 
rovinou spojenou s linií vybranou při vytváření řezací operace. Než začne řezání, otáčí se 
nástroj do polohy rovnoběžné s normálou (osa W) k pracovní rovině.  

Chcete-li se dozvědět víc o vytváření a úpravách pracovních rovin, přečtěte si kapitolu 
"Vytváření pracovních rovin" na straně 66. 

Místo použití standardní otočné hlavy je pro tuto lekci definována individualizovaná otočná 
nástrojová hlava. Typ otočné nástrojové hlavy (Turret Type) je nastaven na Custom a 
rozměry hlavy jsou specifikovány v parametru Turret Definition.  
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Na stránce Spindles umožňují definice pro osu C frézovat na průměru součástky. Materiál 
se otočí do potřebné polohy a pak během provádění frézovací operace zůstává v klidu. V 
této lekci se používají standardní nastavení.  

 
Stejně jako u osy B se i nastavení osy C v nastavení stroje (Machine Setup) používají v 
kombinaci s pracovní rovinou spojenou s linií vybranou při vytváření řezací operace. Než 
začne řezání, otočí se materiál tak, aby normála (osa W) k pracovní rovině byla rovnoběžná 
s nástrojem. Nastavení pohybu v ose Y na stránce Turrets rozhodují o tom, jak daleko se 
může nástroj pohybovat ve směru Y. 

Chcete-li ukončit nastavení stroje (Machine Setup), vyberte Cancel. 
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Vytváření konturovacích operací v ose C 

V ESPRIT může být libovolná operace, která se dá provést na fréze, provedena také na 
soustruhu. Operace, které jsou k dispozici v menu SolidMillTurn, jsou stejné jako operace 
dostupné pro SolidMill. Jediný rozdíl je, že operace SolidMillTurn mají navíc stránku 
Strategy technology, kde můžete specifikovat vřeteno a otočnou nástrojovou hlavu pro 
příslušnou operaci. Jinak jsou operace a nastavení přesně stejné.  
1 Z menu Machining vyberte Machining →SolidMillTurn → SolidMillTurn, aby se 

zobrazil panel nástrojù. 

2 Ve Feature Manager vyberte C Chain. Budete aplikovat konturovací operaci na tuto 
linii. (V případě potřeby vyvolejte stisknutím klávesy F2 Project Manager.)  
 

 

Pracovní rovina 'C Plane' je spojena s touto linií. Všimněte si, že osa W je umístěna 
kolmo a směřuje od čela. 

3 Vyberte Contouring          z panelu nástrojů SolidMillTurn.  
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4 Vyberte 1 in EM jako Tool ID a napište C Hex Cut jako název operace (Operation Name).  
 

 

5 Vyberte kartu General. 

6 Zadejte hodnotu 20 pro Clearance. Zadejte 0 pro Incremental Depth.  
 

Nastavte Type of Cut na FACE MILLING. 
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Nastavte Offset Side Computer na Right. Budete obrábět na pravé straně vybrané 
linie. Nastavte Offset Tool Radius na Yes a Cutter Comp NC na Off.  

 
7 Vyberte kartu Common, nastavte Lead-In Type na Tangent a zadejte 0,5 pro 

Tangent Distance.  

Nastavte Exit Mode na Over Then Up a zadejte 6,0 pro Tangent Distance.  

Standardně je parametr Lead-Out Type nastaven stejně jako Lead-In Type.  
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8 Vyberte kartu Rgh & Fin a přesvědčte se, že je parametr Rough Strategy nastaven na 
1 průchod a parametr Finish Strategy na 0 průchodů.  

 

 
 
9 Stiskněte OK, aby se vytvořila operace.  
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Nyní, když máte vytvořenou konturovací operaci, ušetříte čas tím, že budete otáčet kopie 
operace a obrábět každou stranu šestihranného tvaru. 

1 V rozbalovacím menu Work Planes vyberte YZX.  

2 S použitím režimu HI vyberte 
konturovací operaci, kterou jste právě 
vytvořili.  

 

 

3 Stisknutím kláves Ctrl+C otevřete dialogové okno Copy.  

4 Nastavte Transformation Type na Rotate. 

5 Vyberte Copy a zadejte 4 pro počet kopií 
(Number of Copies). 

6 Zadejte 60 pro úhel mezi kopiemi (Angle 
Between Copies) a stiskněte klávesu Tab. 
Je automaticky vypočítána hodnota 
celkového úhlu (Total Angle). 

7 Zaškrtněte Use Origin for Rotation Axis. 

8 Stiskněte OK. 
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Operace je okopírována a otočena okolo osy W v aktuální pracovní rovině.  
 

 
 

Kromě toho je automaticky okopírována řetězcová linie spojená s 
operací.  
Podle potřeby jsou vytvořeny nové pracovní roviny. Pokud je nalezena 
existující pracovní rovina, použije ESPRIT tuto pracovní rovinu. 
Všechny linie musí být spojené s pracovní rovinou.  
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Vytváření konturovacích operací v ose B 

Dále budete vytvářet konturovací průchody pro řezání zkosených čel součástky. Na jednom 
ze zkosených čel již byly vytvořeny řetězcové linie. Tyto řetězcové linie jsou spojené s 
pracovní rovinou s názvem 'B Plane'. 

1 Ve Feature Manager vyberte B Chain 1. 

2 Vyberte Contouring         z panelu nástrojů SolidMillTurn.  

3 Vyberte kartu General. 

4 Přesvědčte se, že je ToolID nastaveno na 1 in EM. 

5 Nastavte Offset Side Computer na Left. Změňte název operace (Operation Name) na 
B Hex Cut.  

 

 

 

 

 

 

 

 



142   Začínáme s Esprit 

6 Vyberte kartu Common a změňte Start Overcut % na 40. Změňte Tangent Distance 
pro vysouvání na 0,50.  

 

Parametry Start Overcut %/End Overcut % se používají k posunutí počátečního nebo 
koncového bodu sekvence s použitím procentuální části průměru nástroje. Je možné 
zadat kladnou nebo zápornou hodnotu. 

7 Stiskněte OK, aby se vytvořila operace.  
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Druhá řetězcová linie na zkoseném čele používá stejná nastavení operace. 

1 Ve Feature Manager vyberte operaci B Hex Cut, kterou jste právě vytvořili. 

2 Přidržte stisknutou klávesu Ctrl a přetáhněte operaci do B Chain 2.  

Operace je okopírována a aplikována 
na druhou linii. 

Nyní okopírujete tyto operace na 
každé zkosené čelo. 

1 S použitím režimu HI vyberte 
dvě operace na zkoseném 
čele.  

Tip: Při vybírání druhé 
operace přidržte stisknutou 
klávesu Ctrl.  

2 Stiskněte klávesy Ctrl+C. 

3 Změňte počet kopií (Number of Copies) na 5. 

4 Zadejte 360 pro celkový úhel (Total Angle) a stiskněte klávesu Tab. 

5 Stiskněte OK. 
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Stejně jako předtím je linie okopírována a podle potřeby jsou vytvořeny s ní spojené pracovní roviny. 

 
S použitím Property Browser (Alt+Enter) zobrazte, která pracovní rovina je spojena s každou 
linií. 

S použitím stejných principů můžete aplikovat obrábění kapes a operace zbytkového 
obrábění na zbytek linií na průměru materiálu a na zkosených čelech. Další informace o 
standardních frézovacích operacích najdete v kapitole “Vytváření standardních frézovacích 
operací” na straně 35. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



 

 

 

 

 

 

 

 

 

 

 

Lekce 6

SolidWire Gold

Tato lekce vysvětluje, jak rychle vytvářet linie pro drátové EDM operace. Budete 
aplikovat operace obrábění kapes na každou linii ve skupině linií a vytvářet lisovací 
konturovací operace. Rovněž se naučíte, jak používat pokročilé třídění na operace 
SolidWire.  

 
 

V této lekci se naučíte toto: 

• Vytvoření skupiny linií     147 

• Typ EDM stroje     152 

• Vytváření operací obrábění kapes     153 

• Vytváření konturovacích operací     156 

• Pokročilé třídění operací     161 
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Tato lekce používá metrické hodnoty. Než začnete s touto lekcí, přesvědčte se, že je 
parametr System Unit nastaven na Metric. V menu vyberte Tools › System Unit › Metric. 

V této lekci budete otevírat existující soubor ESPRIT. 

1 Vyberte Open           ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor:  

Getting Started\SolidWire\EDM_2x_part.esp 

3 Přesvědčte se, že jsou zapnuté režimy HI a SNAP. Stavová 
oblast v pravém dolním rohu obrazovky musí vypadat jako na 
obrázku vpravo.  

 

4 V menu Machining vyberte SolidWire Gold →  

SolidWire Gold pro zobrazení panelu nástrojů. Tím se dostanete do režimu SolidWire.  
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Vytvoření skupiny linií 

Operace SolidWire používají řetězcové linie k definování počátečního místa, směru řezání, 
tvaru a koncového místa pro drát. Potřebujete-li obrábět několik tvarů, může být časově 
náročné vytvořit každou jednotlivou řetězcovou linii jednu po druhé. 

Příkaz Feature Group v menu SolidWire Gold nabízí rychlý způsob, jak vytvořit všechny 
linie na součástce najednou. Pak můžete aplikovat jedinou operaci SolidWire na celou 
skupinu linií. 

1 Změňte rovinu pohledu na pohled shora (Top).  

To usnadňuje vybírání prvků, které chcete zahrnout 
do skupiny linií. 

2 V případě potřeby vyvolejte stisknutím klávesy F2 Project 
Manager. 

Dále budete vybírat prvky pro zahrnutí do skupiny linií. Vyberete 
plný model a body geometrie, které budou použity jako body závitu. 

Důležité   Aby ESPRIT při vytváření skupiny linií identifikoval body geometrie jako body 
závitu, musí být body geometrie umístěny v rovině XY. ESPRIT nenajde body závitu, které 
leží nad nebo pod rovinou XY. 

1 S použitím režimu HI vyberte plný model. 

Dále potřebujete vybrat body závitu. Pro snazší vybírání bodů použijete výběrový filtr. 
Výběrový filtr nutí ESPRIT identifikovat pouze jeden typ prvku. 

2 V rozbalovacím seznamu Selection Filter vyberte Point.  
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3 Přidržte stisknutou klávesu Ctrl a přetáhněte výběrové okénko na celou součástku. 
Nyní jsou všechny body zahrnuty ve skupině. 

Poznámka   Přidržení stisknuté klávesy Ctrl během vybírání umožňuje přidávat nové 
prvky do existující skupiny. 

4 Vyberte Feature Group            z panelu nástrojů 
SolidWire Gold.  

Nastavení v dialogovém okně EDM Feature Group Finder 
určují, které prvky jsou brány v úvahu pro skupinu linií, jak 
vyhledávat body závitu a zda se vyhýbat vyvrtaným 
otvorům na součástce. 

V této lekci budeme hledat pouze geometrii, která tvoří 
uzavřený profil. 

Nastavení pro Profile Orientation, Point Search Range 
a Point Search Side se používají k vyhledávání bodů 
závitu v seskupených prvcích. 

S použitím parametrů Profile Orientation a Point Search 
Side je vypočítáno dočasné pásmo obklopující seskupené 
prvky. Point Search Range určuje vzdálenost pásma od 
seskupených prvků. Jakmile je vytvořeno pásmo, 
vyhledává EDM Feature Group Finder body uvnitř 
vypočítané plochy. Každý nalezený bod je považován za 
bod závitu. 

Pokud není nalezen bod závitu, je vytvořen s použitím 
parametrů Alignment Angle a Lead-In Offset Value. Další 
informace o skupinách linií naleznete v nápovědě ESPRIT 
po stisknutí klávesy F1. 

5 Použijte zobrazená nastavení a stiskněte OK. 
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Jsou automaticky vytvořeny linie pro každý uzavřený profil a bod závitu. Skupina linií a 
jednotlivé linie mohou být zobrazeny v Project Manager. Když je linie vybraná ve 
Feature Manager, zvýrazní se na pracovní ploše.  

 
6 Nastavte Selection Filter opět na All.  
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Protože jsou parametry definované v dialogovém okně Feature Group Finder aplikovány na 
všechny linie vytvořené s použitím příkazu Feature Group, je bod závitu pro vnější profilovou 
linii umístěn na nesprávné straně součástky. Vzhledem k tomu, že se jedná o lisovník, musí 
být bod závitu umístěn na vnější straně součástky. To se dá snadno do pořádku. 

1 Stisknutím kláves Alt+Enter vyvolejte Property Browser. 

2 Vyberte vnější profilovou linii, aby se zobrazily její vlastnosti.  

Všimněte si, že linie má vlastnosti pro bod zavedení 
(Lead-In Point), počáteční bod (Start Point), bod 
vysunutí (Lead-Out Point) a koncový bod (End Point).  

Tyto hodnoty můžete změnit. 

3 Vyberte hodnotu vpravo od Lead-In Point. Vedle 
hodnoty se objeví výběrová šipka. 

4 Klepněte na výběrovou špiku a pak vyberte bod 
na vnější levé straně plného modelu.  

Souřadnice polohy vybraného bodu se vrátí jako 
nová poloha bodu zavedení. 

5 Změňte Lead-Out Point na stejnou polohu.  

Vyberte hodnotu v Property Browser, klepněte na 
výběrovou šipku a pak zvolte stejný bod jako v 
kroku 4. 

Linie se nyní zobrazí jako na ilustraci.  

Výhoda používání skupin linií spočívá v tom, že 
můžete aplikovat jedinou obráběcí operaci na 
celou skupinu. 

V této lekci vytvoříte jedinou operaci obrábění 
kapsy a aplikujete ji na všechny malé kapsy na 
vnitřní straně součástky.  
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Budete provádět konturovací operace na vnitřních či vnějších profilech tak, že je 
přetáhnete ven ze skupiny linií. 

1 Ve Feature Manager vyberte 
linii pro vnější profil a 
přetáhněte ji na pracovní 
souřadnici XYZ.  

 
Linie je umístěna mimo 
skupinu linií.  

 
2 Vyberte linii pro vnitřní profil a 

rovněž ji přetáhněte na 
pracovní souřadnici XYZ.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Nyní můžete provést na těchto 
liniích samostatné konturovací 
operace a jedinou operaci 
obrábění kapsy na skupině 
linií.  
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Typ EDM stroje 

Než začnete vytvářet drátové EDM operace, musíte specifikovat typ EDM stroje. Nastavení 
na stránkách technologie SolidWire vycházejí z typu EDM stroje, který vyberete. 

1 V menu vyberte Tools → EDM Machine Type. 

2 Přesvědčte se, že je vybrán typ stroje Generic (new strategies) a stiskněte OK.  
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Vytváření operací obrábění kapes 

Operace obrábění kapsy ESPRIT SolidWire využívá souosé průchody k odstranění veškerého 
materiálu uvnitř uzavřené hranice směrem zevnitř ven. 
 
1 Vyberte Pocketing            z menu SolidWire Gold. 
 
2 Nastavte Pocketing rough strategy na Normal, Step over amount na 0,2 a Thread hole 

diameter na 2,0.  
 

 
Normální (Normal) strategie vytváří řezací průchody na základě tvaru linie a velikosti 
přechodu. Souosá strategie vytváří kruhové řezací průchody, dokud drát nedosáhne 
linie. 
 
Thread hole diameter určuje průměr předvrtaného závitového otvoru. Zadání hodnoty 
průměru šetří čas, protože ESPRIT neřeže uvnitř plochy definované touto hodnotou. 
 

3 Nastavte Workpiece top na 13. 
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4 Vyberte kartu Cut Settings a nastavte strategii řezání (Cut strategy) na Rough+1Skim. 
Nastavte vstupní / výstupní vzdálenost (entry/exit) pro čisticí průchod na 2,0.  

 

5 Stiskněte tlačítko Features... na spodním okraji dialogového okna. 

Poznámka   Tlačítko Features se zobrazí, pouze když je skupina linií uvedena ve Feature 
Manager. 

6 Vyberte skupinu linií a stiskněte OK. Tato nastavení operací budou aplikována na 
všechny linie ve vybrané skupině.  
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7 Stisknutím OK v dialogovém okně Pocketing vytvořte operace.  

Pro každou linii ve skupině jsou vytvořeny souosé hrubé průchody a pak čisticí průchod.  
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Vytváření konturovacích operací 

Nejprve budete konturovat vnitřní profil součástky s lehkým zkosením. Skončíte 
konturováním vnějšího profilu. 

1 Vyberte Contouring           z panelu nástrojů SolidWire Gold. 

2 V rozbalovacím seznamu Machining Processes vyberte Night Die [Rough] [Cut-off] 
[Skim].  

 

Obráběcí proces kontroluje pořadí řezacích průchodů. Když je vybrána skupina linií, je 
na všechny tvary ve skupině aplikována položka v první závorce, potom položka v další 
závorce atd. 

Night Die provádí nejprve všechny hrubé řezy, od první linie ve skupině po poslední. 
Potom jsou vytvořeny všechny vyřezávací průchody, za nimiž následují všechny čisticí 
řezy. 

3 Nastavte Entry and exit moves na Distance a zadejte hodnotu vzdálenosti 2,5. 

4 Nastavte Cut-off strategy na Taper a potom Cut-off distance na 5 a Glue distance na 2. 
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Kromě vzdálenosti vyřezávání můžete specifikovat samostatnou hodnotu vzdálenosti 
lepení. Větší vzdálenost vyřezávání pomáhá zachovat pevnost lisovníku během provádění 
hrubovacích a čisticích průchodů. Menší vzdálenost lepení umožňuje operátorovi stroje 
provádět opatření pro lisovník, který volně padá. 

5 Přesvědčte se, že jsou zaškrtnuty možnosti Always cut and re-thread wire, Stop before 
cut-off a Slug stop. 

Později v této lekci budete měnit pořadí operací. Always cut and re-thread wire řeže a 
znovu navíjí drát v původním bodě závitu po každém řezacím průchodu. Po změně pořadí 
operací nemusí řezání a opětovné navíjení proběhnout v první operaci v sekvenci. 

6 Vyberte kartu Cut Settings a nastavte Workpiece top na 13.  

Strategie řezání se nastavuje na stránce Taper Settings.  
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7 Vyberte kartu Taper Settings a nastavte strategii řezání (Cut strategy) na Rough+2Skims. 
Nastavte Taper angle na 1. 

 
8 Stiskněte OK.  
 
9 Na pracovní ploše vyberte vnitřní profilovou linii. 
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Operace jsou přidány do Project 
Manager.  

Nyní vytvoříte konturovací operaci okolo 
vnější strany součástky. 

1 Vyberte Contouring           z panelu nástrojů SolidWire Gold. 

2 Pro obráběcí proces vyberte Punch [Rough & Skim][Cut-off]. Nástroj provádí 
nejprve hrubování a čištění a potom vyřezávání.  
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3 Nastavte Offset side na Right a Cut-off Strategy na Vertical a změňte vstupní/výstupní 
vzdálenost (Entry/exit distance) na 5,0. 

4 Vyberte kartu Cut Settings a nastavte strategii řezání (Cut strategy) na Rough+2Skims.  

 

5 Vyberte kartu Taper Settings a nastavte Taper angle na 0. 

6 Stiskněte OK. 

7 Na pracovní ploše vyberte vnější profilovou linii a vytvořte operace.  
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Pokročilé třídění operací 

V Operations Manager jsou operace momentálně seřazeny podle linií. Seřadíte operace tak, 
aby se jako první prováděly všechny hrubovací práce. 

1 V Operations Manager vyberte první 
operaci a pak při stisknuté klávese Shift 
vyberte operaci 15. 

Jsou vybrány všechny operace kromě operací 
pro vnější konturu. 

2 Vyberte Advanced Operation Sorting           z panelu nástrojů SolidWire Gold.  

3 V dialogovém okně klepněte na výběrovou šipku vpravo od Select Contour a pak 
vyberte na pracovní ploše vnitřní profilovou linii.  

 
Začnete třídit s touto linií. 
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4 Nastavte Sort By na [Rough][Cut-off][Skim].  

Všechny hrubovací operace budou seřazeny a umístěny 
na začátek seznamu operací, za nimi všechny 
vyřezávací operace a potom všechny čisticí. 

5 Nastavte Insert v seznamu operací (Operations List) na 
At Start.  

Tím umístíte linii, kterou jste vybrali v kroku 3, na 
začátek seznamu operací. 

Optimize for Shortest Travel Path používá metodu 
třídění, která minimalizuje vzdálenost mezi liniemi, 
počínaje první linií. Tento algoritmus má tendenci 
sledovat při hledání nejkratší dráhy klikatou čáru a snaží 
se přitom vyhýbat nežádoucímu křížení.  

Reverse second cut order převrací pořadí linií všech 
ostatních operací. 

6 Chcete-li si prohlédnout efekt těchto nastavení v 
Operations Manager, vyberte Apply.  

7 Stiskněte OK. 

Pokud chcete provést změnu pořadí jednotlivých 
operací, můžete je metodou drag-and-drop umístit 
kdekoli v seznamu operací. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Lekce 7

SolidWire Platinum

S použitím této lekce se naučíte, jak vytvořit a používat specializovanou linii pro 
4-osé drátové EDM konturovací operace. 

 

 
 

V této lekci se naučíte toto: 

• Vytvoření linie EDM4     165 

• Vytvoření 4-osé konturovací operace     168 
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Tato lekce používá metrické hodnoty. V menu vyberte Tools → System Unit → Metric. 
Přesvědčte se, že jsou zapnuté režimy HI a SNAP.  

V této lekci budete otevírat existující soubor ESPRIT. 

1 Vyberte Open           ze standardního panelu nástrojů. 

2 Na ESPRIT CD vyberte následující soubor: Getting 
Started\SolidWire\EDM_4x_extrusion.esp 

3 V menu Machining vyberte SolidWire Platinum →¨ SolidWire Platinum, aby se 
zobrazil panel nástrojů.  

 
 
Při vytváření 4-osé konturovací operace obvykle potřebujete vybrat profil XY, profil UV 
a všechny synchronizační čáry, které chcete zahrnout. V ESPRIT zjednodušuje tento 
proces linie EDM4, protože obsahuje všechny obráběcí informace nezbytné pro 4-osé 
drátové EDM operace. 
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Vytvoření linie EDM4 

1 Vyberte EDM4 Feature Solid           z panelu nástrojů SolidWire Platinum. 

2 Přesvědčte se, že je parametr Profile Orientation nastaven na CW. 

3 Nastavte Part Type na Punch.  

Toto nastavení určuje, kde se vytvoří body zavádění a 
vysouvání. Při nastavení na Punch jsou body zavádění a 
vysouvání na vnější straně součástky. 

4 Nastavte Start Point na Edge. 

Počáteční bod linie bude vytvořen na přibližné hraně s 
ohledem na první čelo vybrané v závislosti na 
nastaveních pro orientaci profilu (Profile Orientation) a typ 
součástky (Part Type). 

5 Nastavte Lead-In/Out Position na Normal. 

Body zavádění / vysouvání budou umístěny normálně v 
počátečním bodě linie. 

6 Nastavte Lead-In/Out Value na 5,0. 

Tato hodnota kontroluje umístění bodu závitu. Vzdálenost se měří od počátečního bodu 
linie a je založena na poloze zavádění / vysouvání. 
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7 Přesvědčte se, že je zaškrtnuta možnost Automatic Selection, a pak s použitím režimu 
HI vyberte levé čelo součástky jako na ilustraci.  

 
Když odpovíte "Ano" stisknutím levého tlačítka myši, vyberou se automaticky všechna 
čela kolem plného modelu a přidají do seznamu v dialogovém okně. Pokud chcete vybrat 
čela ručně, zrušte zaškrtnutí možnosti Automatic Selection.  
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8 Stiskněte OK, aby se vytvořila linie 
EDM4. 

Jsou vytvořeny řetězcové linie pro profily XY 
a UV.  

Kromě toho obsahuje linie EDM4 
synchronizační čáry mezi dvěma profily a 
bodem závitu. 

Poznámka   Rovněž je možné vytvořit linii EDM4 z prvků drátové kostry. Další 
informace naleznete v nápovědě ESPRIT po stisknutí klávesy F1. 

Obraťme směr linie tak, aby řez procházel v opačném směru. 

1 V menu vyberte Edit → Features. 

2 Vyberte Reverse z panelu nástrojů.  

 

3 S použitím režimu HI vyberte linii EDM4. Směr linie je nyní obrácený. 
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Vytvoření 4-osé konturovací operace 

Nejprve musíte vybrat typ EDM stroje. 

1 V menu vyberte Tools → EDM Machine Types. 

2 Přesvědčte se, že je vybrána možnost Generic (new strategies) a stiskněte OK. 

3 Vyberte 4-Axis Contouring           z panelu nástrojů SolidWire Platinum. 

4 Nastavte Offset side na Right.  

Nastavte Cut-off strategy na Tab a zadejte Cut-off distance 2,0. 
Zaškrtněte Stop before cut-off a Slug stop. 

 

 

 

 

 

 

 

 

 

 
 

 

 



Lekce 7    SolidWire Platinum    169 

 

5 Vyberte kartu Cut Settings a nastavte strategii řezání (Cut Strategy) na Rough+1Skim.

 

6 Nastavte Program plane heights jako na ilustraci. 

7 Stiskněte tlačítko Features... . 

 
8 Vyberte linii EDM4, kterou jste vytvořili, a stiskněte OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



170   Začínáme s Esprit 

9 Stisknutím OK na stránce konturování vytvořte operaci. 
 

 

10 V menu Machining vyberte Simulation.  

11 Vyberte Run          
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 



 

 

 

 

 

 

 

 

Lekce 8 

KnowledgeBase 

V lekci 1, “SolidMill Traditional,”, jste se naučili, jak ručně vytvářet standardní 
frézovací operace. V této lekci se naučíte, jak připravovat data v ESPRIT 
KnowledgeBase™ a pak používat tyto informace pro automatizaci 
obráběcích procesů. Tato lekce využívá stejnou součástku jako lekce 1, aby 
bylo lépe ilustrováno množství času, které můžete ušetřit s použitím 
KnowledgeBaseTM.  

 

 
 
V této lekci se naučíte toto: 

• Přidání nástrojů do Cutting Tool KB Manager     174 

• Používání Feeds and Speeds KB Manager     179 

• Nastavení standardních hodnot v Default Process KB Manager     189 

• Používání Part/Feature KB Manager     196 

• Definování obráběcích procesů v Process KB Manager     205 

• Automatizace obráběcích operací     211 
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ESPRIT KnowledgeBaseTM značně zvyšuje produktivitu a automatizační kapacitu 
ESPRIT. KnowledgeBaseTM obsahuje rozsáhlou databázi podávání, rychlostí a 
materiálů a také ANSI/ISO kódovanou knihovnu nástrojů, která nabízí optimální 
rychlosti podávání a nástroje pro obrábění vašich součástek. K informacím 
uloženým  v KnowledgeBaseTM se může dostat kdokoli během relace ESPRIT.  

KnowledgeBaseTM se dá rovněž používat k ukládání nejčastěji používaných 
operací a nastavení nástrojů stejně jako pro klasifikaci linií na základě kombinace 
typu součástky a typu linie. Linie pak mohou být automaticky identifikovány podle 
typu součástky a spojeny s posloupností obráběcích kroků nazývanou proces.  

KnowledgeBaseTM se skládá z pěti integrálních komponent obsahujících 
informace, které používá ESPRIT při vytváření automatizovaných NC programů: 

•  Cutting Tool KB Manager 

•  Feeds and Speeds KB Manager 

•  Process KB Manager 

•  Default Process KB Manager 

•  Part/Feature KB Manager 

Uložené informace o řezných nástrojích, podávání a rychlostech a o standardních 
technologických nastaveních jsou spojeny se skupinou automatizovaných 
obráběcích procesů a zkombinovány s automatickou identifikací linií pro vytvoření 
"plánu procesu". Plánovací informace o procesu uložené v KnowledgeBaseTM 
obsahují detailní popis, jak má být součástka obrobena, což urychluje a usnadňuje 
cestu od navržení součástky po její výrobu. 
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Tato lekce používá metrické hodnoty. V menu vyberte Tools → System Unit → Metric. 
Přesvědčte se, že jsou zapnuté režimy HI a SNAP.  

V této lekci budete importovat plný model uložený jako soubor Parasolid (.x_t). 

1 Vyberte Open           ze standardního panelu nástrojů. 

2 Na CD ESPRIT vyberte následující soubor Parasolid: 
\Getting Started\SolidMill\Mill_Part_A.x_t 

3 Vyberte Open.  

4 Z menu Machining vyberte Machining → KnowledgeBase → KnowledgeBase, aby 
se zobrazil panel nástrojù.  
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Přidání nástrojů do Cutting Tool KB Manager 

Cutting Tool KB Manager je externí referenční databáze nástrojů používaných v 
ESPRIT. Kromě standardních nástrojů, které jsou zde k dispozici, můžete v 
KnowledgeBase™ vytvářet a spravovat své vlastní nástroje. Pro snazší vyhledávání 
můžete ukládat nástroje do různých skupin. 

Nyní vytvoříte svou vlastní skupinu nástrojů a pak přidáte nástroje do skupiny. 

1 Vyberte Cutting Tool KB Manager           z panelu nástrojů. 

2 Klepněte pravým tlačítkem myši kdekoli v seznamu Tool Groups a vyberte New... 
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3 Napište My Tools jako název nové skupiny.  

 
4 U dolního okraje dialogového okna vyberte Filter>> a nastavte System Unit na Metric. 

Nastavte Tool Type na End Mill.  
 

Seznam Non Members je aktualizován a zobrazí se v něm všechny metrické čelní frézy 
uložené v KnowledgeBaseTM, bez ohledu na skupinu. 
 
Vaše skupina nástrojů momentálně neobsahuje žádné nástroje. Nástroje můžete 
přidávat do skupiny tak, že je přemístíte ze seznamu Non Members do seznamu 
Members. 
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5 Stisknutím tlačítka >> přemístěte všechny nástroje ze seznamu Non Members do 
seznamu Members. 

 
Poznámka   S použitím tlačítek umístěných mezi dvěma seznamy můžete 
přemísťovat nástroje z jednoho seznamu do druhého a zase zpět. 
 

6 Stiskněte OK, aby se vytvořila nová skupina. 
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Nová skupina je přidána do seznamu Tool Groups spolu se všemi nástroji, které 
jste přidali do seznamu Members.  
 

 
 

Nové nástroje můžete vytvářet také tak, že klepnete pravým 
tlačítkem myši kdekoli v seznamu Tools a vyberete Mill Tools 
(Frézovací nástroje) nebo Lathe Tools (Soustružnické 
nástroje). Chcete-li upravovat nástroje, které jste okopírovali, 
vyberte nástroj v seznamu, klepněte pravým tlačítkem myši a 
vyberte Edit.  

Cutting Tool KB Manager může obsahovat libovolný počet 
skupin nástrojů a řezných nástrojů. Skupina nástrojů může 
obsahovat libovolný počet a jakoukoli kombinaci frézovacích a 
soustružnických nástrojů. Jak jste se naučili v této lekci, jeden 
nástroj může být členem více než jedné skupiny nástrojů. 
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Můžete přesně kontrolovat, které nástroje se zobrazí v seznamu Tools, tak, že aplikujete 
filtrační kritéria. To značně usnadňuje vyhledávání a vybírání nástrojů, které potřebujete. 
Seznam Tools můžete filtrovat podle kteréhokoli z kritérií použitých při definování řezných 
nástrojů. 

1 U horního okraje dialogového okna Cutting Tool KB Manager vyberte Tool Filter        . 

2 Nastavte Tool Style na 1-End Mill a vyberte Apply.  

 
Nyní se v seznamu Tools zobrazí pouze čelní frézy. 

3 Vyberte Exit. 

4 Vyberte Clear Tool Filter             chcete-li rekonstruovat seznam. 

Kromě toho můžete přidávat nástroje z KnowledgeBase™ přímo do aktuální relace 
ESPRIT. 

1 V případě potřeby vyvolejte stisknutím klávesy F2 Project Manager. 

2 V seznamu Tools vyberte nástroj DR 04.5. 

Chcete-li vybrat několik nástrojů, přidržte během vybírání stisknutou klávesu Ctrl nebo 
Shift. 

3 U horního okraje dialogového okna vyberte Add Selected Tools to ESPRIT            
nebo klepněte pravým tlačítkem myši v seznamu Tools a vyberte Add Tools to 
ESPRIT.  

Nástroj je přidán do Tool Manager.  

4 Volbou Exit zavřete Cutting Tool KB Manager. 
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Používání Feeds and Speeds KB Manager 

Feeds and Speeds KB Manager umožňuje definovat své vlastní materiály pro součástky a 
nástroje a individualizovat podávání a rychlosti na základě libovolné kombinace materiálu 
součástky, typu operace a materiálu nástroje. 

Nejprve přidáte svůj vlastní materiál do KnowledgeBaseTM. Začnete tak, že definujete 
novou třídu materiálu. Materiály jsou definovány podle klasifikace a stavu materiálu během 
obrábění. 

1 Vyberte Feeds and Speeds KB Manager           z panelu nástrojů KnowledgeBase. 

2 Vyberte kartu Classes. Stránka Classes obsahuje všechny třídy materiálů v 
KnowledgeBase™. 

 

3 Klepněte pravým tlačítkem myši v seznamu Classes a vyberte New...  
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4 Napište 00My Class jako klasifikaci nového materiálu.  

 

Nuly na začátku názvu umísťují materiál na začátek seznamu, takže je později snazší 
ho najít. 

5 Vyberte Material Condition v seznamu Non Members a s použitím tlačítka > 
přemístěte do seznamu Members. 

6 Stisknutím OK přidejte novou třídu materiálu do KnowledgeBaseTM. Stejnou metodu 
můžete použít k přidání nového stavu materiálu. 

7 Vyberte kartu Materials. 

Nyní vytvoříte svůj vlastní materiál s použitím třídy, kterou jste právě vytvořili. 
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8 Klepněte pravým tlačítkem myši v seznamu materiálů a vyberte New...  

 
 
9 Napište 00My Material jako název materiálu (Material Name).  

 

10 Zaškrtněte Include in Favorites List. Později můžete seřadit materiály tak, aby se 
zobrazily jen vaše oblíbené. 

11 Vyberte 00My Class v seznamu Non Members a přemístěte do seznamu Members. 
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12 Stisknutím OK přidejte nový materiál. 
Když vyberete kartu Groups, uvidíte, že je zde uveden váš nový materiál a jeho třída a stav. 
Můžete vybrat jakoukoli třídu materiálu a zobrazit všechny stavy a materiály spojené s touto 
třídou. 

 

Poznámka   Rovněž můžete přidat novou třídu (Class), stav (Condition) nebo materiál 
(Material) na stránku Groups tak, že klepnete pravým tlačítkem myši v některém ze seznamů 
a vyberete New... 

Dále přidáte materiál řezného nástroje a typ operace. Tyto parametry se používají v 
kombinaci s materiálem, který jste vytvořili, k definování vlastních nastavení podávání 
a rychlosti. 

1 Vyberte kartu Cutter Materials. 

2 Klepněte pravým tlačítkem myši v seznamu materiálů a vyberte New...  
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3 Napište My Cutter Material jako 
název.  

4 Stisknutím OK přidejte materiál řezného 
nástroje.  

5 Vyberte kartu Operations. 

6 Klepněte pravým tlačítkem myši v seznamu operací a vyberte New...  

7 Napište My Operation jako název.  

8 Stisknutím OK přidejte typ operace. 

 
Skončíte definováním svých vlastních podávání a rychlostí. 

1 Vyberte kartu Feed Speed Data. 

2 Nastavte Unit na Metric a Material Class na 00My Class. 

3 Nastavte Operation na My Operation a Tool Material na My Cutter Material.  
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4 Klepněte pravým tlačítkem myši v seznamu Speed Feed Data a vyberte New...  
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5 Zadejte následující hodnoty:  

 

Cut Depth/Hole Dia. Inch = 0,39  

Cut Depth/Hole Dia. Metric = 10,0  

Radial Cut Depth Inch = 0,03 

Radial Cut Depth Metric = 0,75 
Speed (SFM) = 230  

Feed = 0,127 

6 Stisknutím OK přidejte data.  

7 Chcete-li vypočítat, jaké podávání a rychlosti by měly být pro určitou velikost 
nástroje či hloubku řezání, vyberte Calculator.  

8 Nastavte Operation na My Operation a Cutter Material na My Cutter Material. 

9 Nastavte Unit na Metric. 
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10 Nastavte Operation Style na Milling a zadejte 10 pro Depth of Cut i Cutter 
Diameter.  

 
11 Vyberte Get Results. 
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ESPRIT vypočítá podávání a rychlosti na základě vašich nastavení. Jedná se o stejná 
nastavení podávání a rychlosti, která jsou vypočítána, když vytváříte operaci a parametr 
Use Feed and Speed KB je nastaven na Yes.  

Zkuste zadat jiná data a sledujte, jaké budou výsledky. 

12 Až budete hotovi, vyberte Exit a pak Exit ve Feeds and Speeds KB Manager. 
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S použitím následujících kroků načtete automaticky svá nastavení podávání a rychlostí, až 
budete příště vytvářet operaci. 

1 Vyberte KnowledgeBase Setup            z panelu nástrojů KnowledgeBase. 

2 Vyberte 00My Class z rozbalovacího seznamu Part Material a stiskněte OK.  
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Nastavení standardních hodnot v Default Process KB Manager 

Default Process KB Manager umožňuje nastavit různé standardní parametry technologie 
(řezací operace a nástroje) pro různé obráběcí situace. Například můžete definovat jednu 
skupinu standardních parametrů pro vysokorychlostní obrábění a jinou skupinu pro výrobní 
obrábění. 

1 Vyberte Default Process KB Manager            z panelu nástrojů KnowledgeBase. 

2 Klepněte pravým 
tlačítkem myši kdekoli v 
seznamu Name a vyberte  
New.  

3 Napište My technology jako 
název nové skupiny a stiskněte 
OK.  

 
Nová skupina je přidána do 
seznamu Names.  
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Nyní, když máte skupinu, přidáte standardní technologii obrábění kapes. Stačí jednou 
definovat standardní parametry a pak je opakovaně používat pro podobné projekty. 
1 Klepněte pravým 

tlačítkem myši kdekoli 
v seznamu Technology 
a vyberte New.  

 
2 V rozbalovacím seznamu vyberte SolidMill - Pocketing.  

Všimněte si, že tento rozbalovací 
seznam obsahuje každou frézovací a 
soustružnickou operaci a každý řezný 
nástroj, které jsou k dispozici v ESPRIT.  
Můžete přidávat standardní 
parametry technologie po jednom 
nebo můžete s použitím tlačítka Add 
All přidat do své skupiny všechny 
technologie v seznamu. 

3 Stiskněte OK. 

Automaticky se otevře stránka technologie obrábění kapes (Pocketing). 
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4 Klepněte pravým tlačítkem myši na hodnotu pro Total Depth a vyberte Edit 
Properties.  

 

5 V dialogovém okně napište 
Feature.Depth a zaškrtněte Locked.  

Při vytváření operace s použitím 
vašich standardních parametrů bude 
hodnota celkové hloubky (Total 
Depth) automaticky nastavena na 
hloubku vybrané linie. 

Zaškrtnutím možnosti Locked 
zabráníte ostatním uživatelům, aby 
při vytváření operací změnili 
standardní nastavení. 

6 Stiskněte OK. 

 

Tentokrát použijete Expression Builder k vytvoření výrazu, který vypočítá hodnotu 
inkrementální hloubky na základě průměru nástroje. 

1 Klepněte pravým tlačítkem myši na hodnotu pro Incremental Depth a vyberte Edit 
Properties. 

2 V dialogovém okně vlastností vyberte Expression Builder         . 
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3 Ve složce KnowledgeBase VB 
Modules vyberte  
Utilities.bas.  

4 V seznamu na pravé straně 
vyberte ConverttoSysUnit. 
 
Tento příkaz konvertuje všechny 
hodnoty ve výpočtu na aktuální 
systémové jednotky. 

5 Vyberte Add Selected Procedure          . 
 
Výraz je přidán do Expression Builder. Dále potřebujete definovat proměnné. 
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6 Dvakrát klepněte na složku 
ESPRIT, aby se zobrazil její 
obsah, a pak otevřete složku 
ESPRIT Objects.  

7 Vyberte Tool1. 

Na pravé straně jsou 
zobrazeny vlastnosti spojené s 
řeznými nástroji. 

8 Procházejte seznam na pravé 
straně a vyberte vlastnost 
ToolDiameter. 

9 Ve výrazu vyberte  
proměnnou <<N As Double>>.  

Tuto proměnnou nahradíte 
vybranou vlastností. 

10 Vyberte Add Selected Procedure  . 
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11 Vyberte proměnnou <<Unit As Integer>>.  

Tuto proměnnou nahradíte vlastností ze 
seznamu. 

12 Procházejte seznam vlastností a 
dvakrát klepněte na vlastnost 
ToolUnit. 

Proměnná je nahrazena vybranou 
vlastností. 

 
 
 
 
13 Stiskněte OK, aby se zavřelo dialogové 

okno Expression Builder.  

Výraz je přidán do dialogového okna 
vlastností pro inkrementální hloubku 
(Incremental Depth). 

14 Stiskněte OK, aby se zavřelo dialogové 
okno Edit Property. 
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15 Na stránce technologie Pocketing stiskněte OK, abyste přidali standardní technologii k 
nové skupině technologií.  

 

 
16 Volbou Exit zavřete Default Process KB Manager. 
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S použitím následujících kroků načtete automaticky své standardní parametry, až budete 
příště vytvářet operaci. 

1 Vyberte KnowledgeBase Setup           z panelu nástrojů KnowledgeBase. 

2 Vyberte My Technology z rozbalovacího seznamu Default Technology a stiskněte OK.  
 

 

Používání Part/Feature KB Manager 

Part/Feature KB Manager umožňuje vytvářet různé typy součástek a spojovat s nimi 
jednotlivé typy linií. Pak můžete spojovat posloupnosti obráběcích operací (nazývané 
obráběcí proces) s libovolnou kombinací typu součástky a linie. Tímto způsobem můžete 
využívat různé strategie obrábění v závislosti na typu součástky. 

Při vytváření linií identifikuje ESPRIT linie součástek a vyvolává správný obráběcí proces z 
KnowledgeBase™. 
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Nejprve vytvoříte individualizovaný typ součástky. 

1 Vyberte Part/Feature KB Manager           z panelu nástrojů KnowledgeBase. 

2 Klepněte pravým tlačítkem myši kdekoli v seznamu Part Types a vyberte New...  

 
3 Jako název (Name) napište My Part.  

4 Stisknutím OK přidejte nový typ 
součástky.  

 
Stejně jako v Cutting Tool KB 
Manager můžete přidávat existující 
typy linií ke svému novému typu 
součástky s použitím seznamů Non 
Members a Members. 
 
V této lekci vytvoříte nový typ linie. 
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Dále vytvoříte individualizovanou linii pro svůj typ součástky. 

1 Klepněte pravým tlačítkem myši kdekoli v seznamu Feature Types a vyberte New...  

 
2 Zadejte My Pocket jako název (Name). Přesvědčte se, že je parametr Unit nastaven na Metric. 

 
Všimněte si, že dialogové okno rovněž obsahuje seznamy Non Members a Members. 
Když vytvoříte nový typ linie, můžete ho přiřadit více než jednomu typu součástek. 

3 Nastavte ESPRIT Feature Type na Feature. 

Podrobné informace o typech linií ESPRIT naleznete v kapitole "Definování linií" na 
straně 26. 
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4 Vedle pole Rule vyberte Expression Builder            

5 Ve složce KnowledgeBase VB Modules vyberte Features.bas. 

6 V seznamu vlastností 
(Properties) klepněte 
dvakrát na IsPocket, 
abyste přidali příkaz k 
výrazu.  

7 Ve výrazu vyberte 
proměnnou <<Feature as 
Esprit.GraphicObject>> a 
napište Feature. 

8 Stiskněte OK. 

9 V dialogovém okně Add 
New Feature Type 
stiskněte OK, abyste přidali 
typ linie My Pocket ke 
svému typu součástky. 

 
 
 
 
 
 
 
 
 
Dále vytvoříte klíč pro tento typ linie, který bude popisovat velikost linie. 
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1 Klepněte pravým tlačítkem myši kdekoli v seznamu Keys a vyberte New...  
 

 
 
2 Napište My Key jako název (Name) a zadejte popis.  
 

 
 

Přesvědčte se, že My Pocket je jediný typ linie uvedený v seznamu Members. 
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3 Stisknutím OK přidejte nový klíč. 

Nyní přidáte hodnoty popisující různé velikosti kapes. Vytvoříte pravidlo, které bude s 
použitím plochy linie určovat, která velikostní kategorie k ní patří. 

1 Klepněte pravým tlačítkem myši v seznamu Values a vyberte New... 

2 Napište Small Pocket jako název (Name).  

3 Pro pravidlo (Rule) napište: 

Feature.Area<=(15,0*15,0*20,0) 

4 Stisknutím OK přidejte novou hodnotu. 

5 Znovu klepněte pravým tlačítkem myši v 
seznamu Values a vyberte New... 

6 Napište Medium Pocket jako název (Name).  

7 Pro pravidlo (Rule) napište: 

Feature.Area<=(30,0*30,0*20,0) 

8 Stiskněte OK. 

9 Přidejte další hodnotu pojmenovanou Large 
Pocket s pravidlem  

Feature.Area>(30,0*30,0*20,0) 
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Nyní máte tři hodnoty pro klíč.  
 

 
10 Volbou Exit zavřete Part/Feature KB Manager. 
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Abyste mohli používat identifikaci linií, musíte nastavit standardní typ součástky. 

1 Vyberte KnowledgeBase Setup            z panelu nástrojů KnowledgeBase. 

2 Vyberte My Part z rozbalovacího seznamu Part Type a vyberte OK.  
 

 
3 V menu vyberte Create → Features, aby se zobrazil panel nástrojů Features. 
4 Vyberte Pocket           z panelu nástrojů Features. 
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5 S použitím režimu HI vyberte horní okraj kapsy.  
 

 
 
6 Odpovězte Yes stisknutím levého tlačítka myši, aby se vytvořila linie. 
7 V případě potřeby vyvolejte Property Browser stisknutím kláves Alt+Enter. 

8 Ve Feature Manager vyberte linii Pocket.  

V Property Browser můžete vidět, že byla linie 
identifikována s použitím nového typu linie, který jste 
vytvořili. 
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Definování obráběcích procesů v Process KB Manager 

Process KB Manager umožňuje vytvořit kompletní obráběcí proces na základě 
libovolného typu linie, uloženého v KnowledgeBaseTM. Když je vytvořena linie, 
porovnává ESPRIT standardní obráběcí proces s identifikovaným typem linie. 
Obráběcí proces může obsahovat libovolný počet a typ řezacích operací. V závislosti 
na obráběcím procesu načítá ESPRIT nástroje z Cutting Tool KB Manager a aplikuje 
řezací operace na vybranou linii. 

V této lekci vytvoříte standardní obráběcí proces pro linii kapsy. 

1 Vyberte Process KB Manager            z panelu nástrojů KnowledgeBase. 

2 Nastavte Part Type na My Part.  

 

3 V seznamu Feature Case vyberte okno napravo od Feature Type a v něm 
vyberte My Pocket. 

4 Stiskněte Enter nebo klepněte levým tlačítkem myši kdekoli v seznamu Feature 
Case. Zobrazí se klíč spojený s typem linie. 

5 Vyberte Medium Pocket jako hodnotu klíče.  

Nyní spojíte obráběcí proces s touto kombinací typu součástky, typu linie a klíče. 
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6 Klepněte pravým tlačítkem myši v seznamu Processes a vyberte New...  

 
7 Pojmenujte nový proces My process a stiskněte OK. 
Nyní přidáte ke svému novému obráběcímu procesu tři řezací operace. Nejprve budete 
hrubovat kapsu, potom čistit zbývající materiál s použitím zbytkového obrábění a nakonec 
dokončíte stěny kapsy. 

1 Klepněte pravým tlačítkem myši v seznamu Process Steps a vyberte New...  

2 V rozbalovacím seznamu Technology 
vyberte SolidMill - Pocketing a pak 
stiskněte OK.  

Abyste ušetřili čas, otevřete existující 
technologický soubor. 

3 Klepněte pravým tlačítkem myši uvnitř 
stránky technologie a vyberte Open... 

 
4 Na ESPRIT CD vyberte následující soubor: 

\Getting Started\KnowledgeBase\Pocketing-Roughing.prc 
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5 Vyberte Open a přidejte nastavení.  

 
Poznámka   Výraz pro Tool ID se zobrazí až po aktualizaci stránky technologie. Např. 
když vyberete kartu Common a potom znovu kartu General. 
 
Může být nutné prozkoumat některá z nastavení a zjistit, jak jsou definována s 
použitím výrazů. Např. identifikátor nástroje (Tool ID) je nastaven na nástroj, který je 3-
krát tak velký jako nejmenší poloměr vybrané linie. ESPRIT vypočítá hodnotu a najde 
nástroj nejbližší vypočítanému průměru v KnowledgeBase™. 
 
Pamatujte si, že název operace (Operation Name) a komentáře (Comments) musí být 
uvedeny v uvozovkách. Pokud tyto textové řetězce nejsou uvedeny v uvozovkách, je 
ohlášena chyba Visual Basic, když se pokusíte aplikovat proces. Jestliže nechcete 
vložit komentář, stačí použít uvozovky hned vedle sebe. 
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Poznámka   Tato nastavení jsou 
jedinečná pro tento proces. Použijete-
li stejný soubor .prc pro jiný proces a 
nezměníte žádné nastavení, zobrazí 
ESPRIT chybové hlášení, protože 
každá položka v KnowledgeBase™ 
musí mít jednoznačné ID. 

Pouhou změnou názvu operace (Operation Name) nevytvoříte jedinečnou operaci.  

Později v této lekci se naučíte, jak kopírovat proces pro jiný typ linie a hodnotu klíče. 

6 Stisknutím OK přidejte nový krok procesu.  

 

7 Znovu klepněte pravým tlačítkem myši v seznamu Process Steps a vyberte New...  

8 Vyberte SolidMill - Rest Machining a stiskněte OK. 

9 Klepněte pravým tlačítkem myši uvnitř stránky technologie a 
otevřete soubor: \Getting 
Started\KnowledgeBase\RestMachining.prc 

10 Stisknutím OK přidejte krok zbytkového obrábění. 

11 Přidejte další krok Pocketing a otevřete soubor 
\Getting Started\KnowledgeBase\Pocketing-
WallFinish.prc  
 
Všechny kroky procesu jsou nyní hotové.  
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12 Volbou Exit zavřete Process KB Manager. 

Dále spojíte stejný proces s hodnotou Small Pocket linie My Pocket. 

1 V seznamu Feature Case změňte hodnotu klíče na Small Pocket a stiskněte klávesu Enter. 

 
Vidíte, že s touto kombinací typu součástky, typu linie a hodnoty klíče nejsou spojeny 
žádné procesy. 
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2 Klepněte pravým tlačítkem myši v seznamu Processes a vyberte Process Members...  

 

3 V dialogovém okně procházejte seznam Nonmembers, dokud nenaleznete položku My Process. 

4 Vyberte My Process a s použitím tlačítka > přemístěte proces do seznamu Members.  
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5 Stisknutím OK okopírujte celý proces.  

 

Nyní, když jste definovali typ linie a spojili s ním standardní obráběcí proces, musíte již 
pouze aplikovat proces.  

Automatizace obráběcích operací 

Když jsou vytvářeny linie, ESPRIT identifikuje a automaticky přiřazuje každé linii typ na 
základě vybraného typu součástky a pravidel definovaných v KnowledgeBase™. Když je 
danému typu linie přiřazen standardní obráběcí proces, musíte již pouze aplikovat 
proces.  
 
Než aplikujete proces, který jste vytvořili, musíte nastavit standardní technologii na 
standardní systémové hodnoty. Všechna nastavení, která nejsou specificky definována v 
Process KB Manager, využívají standardní technologii. Standardní technologie, kterou 
jste vytvořili dříve v této lekci, je neúplná, protože jste definovali jen několik nastavení v 
jedné řezací  
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operaci. Když ESPRIT nemůže najít standardní nastavení pro technologii, hledá, kdy byla 
naposledy použita tato operace, a použijte příslušná nastavení. To může vést k 
neočekávaným výsledkům. 

1 Vyberte KnowledgeBase Setup           z panelu nástrojů KnowledgeBase. 

2 Nastavte Default Technology na Standard Default Technology - Inch &Metric a 
stiskněte OK.  

 
3 Ve Feature Manager vyberte linii Pocket. Chcete aplikovat proces na celou linii, ne na 

hranici nebo dílčí kapsu. 

 
 
4 Vyberte Process Manager        .  

 

 
 
Vidíte, že ESPRIT prohledává KnowledgeBase™ a na základě vybraného typu linie 
určuje, které nástroje načíst a který proces aplikovat. 

 
 
 

 

 

 

 



Lekce 8    KnowledgeBase    213 

 

5 Vyberte Apply.  

Vhodné nástroje jsou načteny do aktuální relace a řezací operace jsou automaticky 
aplikovány na vybranou linii. 

6 Vyberte Exit. 
Kdykoli v budoucnu, až budete mít podobnou linii, stačí aplikovat proces a vaše řezací 
operace budou provedeny automaticky. Identifikace linií a standardní obráběcí procesy 
jsou klíčem k výraznému zkrácení času, který strávíte programováním součástek. 

Důležité   Všechna data z této lekce, která jste přidali do KnowledgeBaseTM, zůstávají 
uložena v KnowledgeBaseTM, dokud je nevymažete. Až dokončíte tuto lekci, 
nezapomeňte vymazat data materiálů, podávání a rychlostí, skupinu nástrojů (ne však 
nástroje), svou standardní technologii, typ součástky a standardní proces, který jste 
vytvořili. 

 
 

 

 

 

 

 

Pozn. překl: Překlad rejstříku angličtině nemá pro českou mutaci význam! 

 

 
 

 




